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Allegro PCB EditorPCB Editor 개요

- Allegro PCB Editor 개요 -

Workstation / PC 기반의 PCB (Printed Circuit Board) 설계도구
고속고집적 PCB 설계를위한여러기능탑재

무제한의작업가능한 PCB Layer를지원한다.
Constraint Manager를통한설계규칙설정환경을제공한다.
부품배치, 배선과관련된강력한편의기능을제공한다.
보드외곽선, Copper작업을위한 Shape 객체를지원한다.
작업중발생하는오류의즉시교정을위한 Online DRC를지원한다.
Cadence Design Entry HDL, OrCAD Capture와연동하는 Circuit Feedback 인터페이스를
지원한다.
Signal Explorer와연동하는 PCB 패턴분석인터페이스를지원한다.
SPECCTRA Auto Router와연동하는 PCB 자동배선인터페이스를지원한다.
입력환경의편의성을고려하여사용자개별설정을지원한다.
(단축키, 마우스제스처, 경로변경등. 사용자개별설정은계정단위로관리)
작업된 PCB Footprint의유출을방지하기위한보안설정기능을제공한다.
다른 Tool과의호환성을위한 File 변환기능을지원한다.
(P-CAD, PADS, OrCAD Layout, DXF, 그외.)
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Allegro PCB EditorPCB Editor 개요

- PCB Editor 실행 -

Cadence SPB Series
시작 -> 프로그램 -> Cadence SPB 16.x -> PCB Editor

OrCAD
시작 -> 프로그램 -> OrCAD 16.x -> OrCAD PCB Editor

- PCB Editor의설계진행순서 -

Netlist Import 또는 Capture / DE HDL에서생성한 *.brd 파일 Load
작업환경설정 (작업영역, 단위, Layer 수, Rules..)
보드외곽선설정

부품배치

배선 / Copper 작업
Board Design Rules Check
Gerber Data 출력
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Allegro PCB EditorPCB Editor 개요

- PCB Editor 파일확장자 -

BRD : PCB Editor Board Design File
PAD : PCB Footprint PAD Symbol File
DRA : PCB Footprint Draw File (Source)
PSM : PCB Footprint, Package Symbol File (Compiled)
BSM : Board Symbol File (Compiled)
ART : Gerber File
DRL : NC Drill Data File
LOG : (대부분)자동작업수행중생성되는로그파일

Color : Color definition File
DAT : PCB Editor format Netlist File

pstchip.dat : PCB Footprint 연결정보
pstxnet.dat : 배선정보
pstxprt.dat : 부품정보
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Allegro PCB EditorPCB Editor 개요

- PCB Editor 파일확장자 -

OSM : Format Symbol File (Compiled)
SSM : Shape Symbol File (Compiled)
FSM : Flash Symbol File (Compiled)
SCR : Script File
TECH : Technology File (Constraints, 설계규칙)
JRL : Journal File, 각종이벤트발생내역을기록

DRL : NC-Drill Data
RPT : Report File

Note
PCB Footprint는 *.dra type의 Source 파일로제작하여 Compile 하는순서로만들어진다.
PCB 작업중 PCB Footprint 부품은 Compile 된것들만사용할수있다.
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Allegro PCB EditorPCB Editor 개요

- PCB Editor 파일연결 -

(.osm)(.bsm)

(.psm)
cross – section
(stackup)

design rules

PCB Board (.brd)



7

Allegro PCB EditorPCB Editor 작업환경

- PCB Editor 작업창구성 -

Console
Window

Status
Area

Menu Bar
Icons/
Tool BarsTitle Bar

Design Window

제어판

Shape tool set

Route tool set

• Title bar :
현재실행중인 Allegro PCB Editor의
이름과현재작업중인파일및작업
폴더명시

• Menu Bar / Icon Toolbars :
PCB Design에필요한명령제공

• Design Window :
PCB 설계작업창

• Consol Window ( 콘솔창) : 
명령입력및명령실행결과출력

• Status Area : 
실행중인명령확인및중지,
커서의 x, y 좌표표시
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Allegro PCB EditorPCB Editor 작업환경

- Tool Bar -

Note
• Tool Bar의버튼으로부품, Shape, 도형을추가/수정및배선, 설정작업등을선택할수있다.

• 메뉴의 View -> Customize Toolbar 에서 Tool Bar의구성요소들을추가/제거/수정할수있다.
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Allegro PCB EditorPCB Editor 작업환경

- Tool Bar -

New - 새파일생성

Open - 파일열기

Save - 파일저장

- File -

Move - 객체이동

Copy - 객체이동

Delete - 객체삭제

Undo - 작업취소

Redo - 취소된작업복원

Fix - 객체고정

Unfix - 객체고정해제

- Edit -

Unrats all - (화면에서)Ratsnest 숨김

Rats all - (화면에서)Ratsnest 표시

Zoom point - 영역확대

Zoom point - Board 영역확대

Zoom in - 확대

Zoom out - 축소

Zoom Previous - 이전상태확대/축소

Zoom Selection - 객체 focus 확대

Redraw - Design 화면새로고침

- View -
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Allegro PCB EditorPCB Editor 작업환경

- Tool Bar -

Grid - Grid 격자점보기 On/Off

Color - Color/Display 설정

Shadow - Shadow mode On/Off

- Setup -

Cmgr - Constraint Manager 호출

Route Ki - 배선허용영역설정

Package Ki - 배치허용영역설정

General Edit - 일반편집모드

Etch Edit - 배선편집모드

- Application mode -

Artwork - Gerber 파일출력

NC drill Param - 드릴출력설정

NC drill Legend - Drill Chart 생성

Odb out - Valor’s Odb++ 파일출력

Report - Report 출력

DRC update - Batch DRC 정보갱신

Help - Cadence Help(도움말) 호출

- Manufacture -

Xsection - Stack up 편집

- Miscellaneous -
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Allegro PCB EditorPCB Editor 작업환경

- Tool Bar -

Element - 객체속성표시

Cns show - 객체의 Constraint 속성표시

Show measure - 거리측정

- Display -

Dehilight - 객체강조취소

Waive DRC - 보류 DRC 설정

Shape add - 다각형 Shape 생성

Shape add rect - 사각형 Shape 생성

Shape add circle - 원형 Shape 생성

Shape select - Shape 선택

Shape void polygon - 다각형 void 생성

Shape void rect - 사각형 void 생성

Shape void circle - 원형 void 생성

- Shape -

Hilight - 객체강조표시

Shape void element - Shape void 생성

Shape edit boundary - Shape 외곽수정

Island delete - Orphaned shape 제거
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Allegro PCB EditorPCB Editor 작업환경

- Tool Bar -

Create detail - Design 상세표기

Line font - Line 속성정의

Linear dim - 직선거리표기

- Dimension -

Angular dim - 객체간각도표기

Leader only - 가이드선만표기

Place manual - Symbol 수동배치

Place manual - Symbol 수동배치
(부품이동/조정목적)

- Place -

Datum dim - x,y 좌표형태거리표기

Leader diametrical - 직경가이드선표기

Leader radial - 곡선가이드선표기

Leader balloon - 풍선형가이드선표기

Leader chamfer - Chamfer 부위가이드선표기
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Allegro PCB EditorPCB Editor 작업환경

- Tool Bar -

Add connect - 배선

Slide - Segment 단위배선이동

Custom smooth - 배선굴곡평활화

- Route -

Fanout - Fanout 생성

Line - Line 생성

Rect - 사각형생성

- Add -

Vertex - 배선수정

Text - 텍스트입력

Text edit - 텍스트수정
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Allegro PCB EditorPCB Editor 작업환경

- Fold Away 방식 Control Panel 표시 / Window 표시제어 -

마우스포인터이동

메뉴표시

창고정 창늘임 창닫기

• 작업영역확보를위해제어판을숨김형태로구성
• 창고정기능으로설정조정가능

창구성요소표시/숨김설정
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Allegro PCB EditorPCB Editor 작업환경

- Control Panel -
Visibility Find

Option

Design 창의색상및
표시여부

객체선택의편의를
위한 Filter

Find by Name

- Design Object -
• Group - 사용자임의지정에의한객체그룹
• Comps - 부품(Part reference 기준)
• Symbols - 부품(Package symbol 기준)
• Functions - Gate function
• Nets - 부품간배선속성
• Pins - 부품핀
• Vias - 배선비아
• Clines - 배선(Connection Lines)
• Lines - 선
• Shapes - Shape(Copper)
• Voids - Shape Void
• Cline Segs - 선단위 Cline
• Other Segs - 선단위 Line
• Figures - 각종기호(Drill…)
• DRC errors - DRC marker
• Text - 모든글자
• Ratsnests - 배선되지않은 Wire
• Rat Ts - Ratsnest 분기점

객체선택편의를위한속성
/ 배선 List

배치/배선등의
작업옵션
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Allegro PCB EditorPCB Editor 작업환경

- Control Panel - / Visibility

Plane Layer 선택

배선 Layer 보기설정

Plane Layer
보기설정

개별 Layer
보기설정

개별항목
보기설정

색상및 Film 보기

Note
Color View는별도의색상으로저장할수있으며,
저장된색상설정은 View list에서지정할수있다.
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Allegro PCB EditorPCB Editor 작업환경

- Popup menu (Default mode) -

Note
사용자편의를위하여, 
Menu/Tool bar의일부
기능을마우스오른쪽
버튼에할당

- 항목설명(일부) -
• Super Filter - Control Panel의 Find Tab과같은역할
• Customize

− Enable Single Click Execution - 한번클릭으로명령자동실행(예 : add connect)
− Disable Automatic Drag Operations - 드래그시, 특정예상작업배제(예 : Slide)
− Enable Shape Selection through Shape Fill - Shape의면을클릭하여 Shape 선택
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Allegro PCB EditorPCB Editor 작업환경

- World View / Status Area -

현재작업여부및작업구분
Coordinates

A : Absolute, 절대좌표
R : Relative, 이전마우스의클릭위치를
기준으로한상대좌표

Pick : 좌표직접입력
(마우스왼쪽버튼클릭또는 Zoom Center)

전체영역 현재표시창 보드외곽선

마우스오른쪽버튼클릭

전체영역 : Board내전체영역표시
현재표시창 : Design Window 상에표시되는
영역
보드외곽선 : 보드외곽선미리보기
마우스오른쪽버튼클릭 – 확대/축소팝업메뉴
호출
(Right Mouse Button > RMB)

좌표계
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Allegro PCB EditorPCB Editor 작업환경

- 단축키 -

Color priorityCF6NextCF2

Zoom worldSF12Zoom outF12

statusSCF5ColorCF5

Zoom previousSF11Zoom inF11

Save_as tempSF10Grid toggleF10

VertexSF9CancelF9

Highlight pickSF8OopsF8

Dehighlight allSF7NextF7

MoveSF6DoneF6

CopySF5RefreshF5

Show measureSF4Show elementF4

SlideSF3Add connectF3

Property editSF2Zoom fitF2

CommandKeyCommandKey

Note
• 환경설정파일저장경로 :

– Global : %Installed DIR%
\share\pcb\text\env

– Local : 환경변수에서
“HOME”으로지정된경로

– 적용우선순위 : Local > Global

• HOME Folder내 env file의내용을수정하여
단축키설정변경
(Alias 및 Funckey 선언)
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Allegro PCB EditorPCB Editor 작업환경

- 단축키 -/ 지정또는수정

Key Map

Modifier Indicator Example
Shift S SF2
Control C (function keys) CF2
Control ~ (alpha-numbic) ~N
Meta A AF2

Key 조합

CSF2 Control-Shift F2
ASF2 Meta-Shift F2
CAF2 Control-Meta F2
CASF2 Control-Meta-Shift F2
~SZ Control-Shift Z
SUp Shift-Up Arrow
CUp Control-Up Arrow

Alias example
alias SF2 grid toggle (그리드 On / Off 실행)

Funckey example
funckey r rotate (부품회전명령실행)

메모장이나워드패드로
env파일을편집
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Allegro PCB EditorPCB Editor 작업환경

- 마우스제스처 -

Ctrl
+

MRL

키보드의 CTRL키와마우스오른쪽버튼을누른상태에서아래표와같은방법으로마우스를움직이면, 
각각의예약된명령어가실행된다.

Stroke Equivalent command Key combinations 

 Copy CTRL+C 

 Move SHIFT+F6 

 Zoom In F11 

 Oops (Undo) F8 

 Zoom World SHIFT+F12 

 Delete — 
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Allegro PCB EditorPCB Editor 작업환경

- 마우스제스처 -/ Stroke Editor

Note
Stroke Editor를이용하여, 사용자
정의마우스제스처를정의한다.
Setup -> User Preference 에서 input 
Category의 no_dragpopup 항목을
설정하면 Ctrl키의입력없이, 마우스
오른쪽버튼만으로제스처
입력기능을사용할수있다. 
(Appendix 참고)

스트로크입력창

명령어입력창
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Allegro PCB EditorPCB Editor 작업환경

- Import Netlist - / OrCAD Capture

Capture의 Create Netlist 기능을호출
하여 BRD파일을자동으로생성한다.

Options : PCB 작업파일저장경로

Input Board : Board Template File
Output Board : PCB Artwork File
Create or Update PCB Editor Board :
BRD파일을생성하고 PCB Editor를
실행하여 BRD 파일을연다.

BRD파일을생성하지않고 Netlist만
출력하고자할때는이옵션을해제한다.

Board Launching Option : BRD파일을
열기위해실행할프로그램을선택한다.

Allegro PCB Editor
OrCAD PCB Editor
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Allegro PCB EditorPCB Editor 작업환경

- Import Netlist - / Import Logic

Capture에서생성된 Netlist 파일을 import하여 BRD 
파일의내용을갱신한다.

Tab
Cadence : 회로도면작업을 Cadence DE HDL이나, OrCAD 
Capture로작성했을경우선택.
Other : 회로도면을다른프로그램으로작성했을경우선택.

Import logic type : 회로도면을작성한프로그램을
선택한다.

SCALD : DE HDL 5.0 이전버전파일의 import

Place changed component : 회로도면상의부품이
변경될경우, PCB상의부품배치를유지할지제거할지
선택한다.

Always : 항상이전부품의배치위치를유지

Never : 항상부품배치를초기화한다.
If same symbol : 변경된부품의 Symbol이이전것과같을
경우만부품배치를유지
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Allegro PCB EditorPCB Editor 작업환경

- Import Netlist - / Create New File

새로운 BRD, 부품, Padstack 파일을생성한다.

Drawing Type
Board : 빈 BRD 파일
Board (Wizard) : Board 에서설정해야할부분을 Wizard 
형식으로진행하여 BRD파일생성

Module : Design Reuse를위한모듈생성

Package Symbol : 빈 DRA 파일
(Package, Mechanical, Shape(PAD), Flash)
Package Symbol (Wizard) : 부품제작의편의를위해
Wizard 형식으로진행하여 DRA, PSM, BSM 파일생성

Format Symbol : Sheet Outline form

Change Directory (Browse창) : 도면작업폴더변경

Note
Netlist를 Import 하기위해, 새로운 BRD파일을미리
생성해야한다.Preview text Preview Board Picture
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Allegro PCB EditorPCB Editor 작업환경

- Import Netlist - / Create New Board File - Wizard

새로운작업파일을문답식으로설정하여생성.
아래의설정을미리완료지을수있다.

치수단위, 도면크기, 원점위치
보드외곽선
그리드간격
PCB 층수
환경설정 (Constraints)
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Allegro PCB EditorPCB Editor 작업환경

Template Data를 import 한다.
Board / Template / Board Outline

User Preference의 BSM Path 또는동일한작업폴더에
import할작업파일이존재해야한다.

- Import Netlist - / Create New Board File - Wizard
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Allegro PCB EditorPCB Editor 작업환경

작업영역설정
치수단위(Unit)
작업영역(인쇄용지크기단위)
원점지정

영역가운데

영역왼쪽아래

그리드설정
그리드간격설정
Layer 수설정(배선층기준, Plane Layer 제외)
Film 구성요소생성여부결정

- Import Netlist - / Create New Board File - Wizard
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Allegro PCB EditorPCB Editor 작업환경

Layer 속성지정
Layer의배선가능여부

Routing Layer
Plane Layer

Plane Layer의출력형태결정
Positive
Negative

환경설정(Constraints)
최소간격설정
배선폭
배선간격 (배선간이격거리)
라인대패드간격
패드대패드간격
기본비아(Via)객체지정

- Import Netlist - / Create New Board File - Wizard
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Allegro PCB EditorPCB Editor 작업환경

보드외곽선설정
형태지정

원형

사각형

가로 / 세로길이 (또는가로 / 세로지름)
가장자리절개(Corner cutoff)
배선가능영역지정 (Route Keep in)
부품배치가능영역지정 (Package Keep in)

- Import Netlist - / Create New Board File - Wizard
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Allegro PCB Editor

- Design Parameters - / Display Tab

환경설정

Display Tab
Display – 화면표시설정

Connect point size : Cpoint (Diamond 형태로표시) 크기설정
(사용자 Unit 설정을따름)
DRC marker size : DRC Marker의크기지정
Rat T (Virtual pin) size : Net schedule 설정에서 Ratsnest의

T분기점크기설정
Max rband count : 객체이동중표현할외곽선의수, 현재는바꿀
필요가없는설정
Ratsnest geometry : Ratsnest의표시방법지정(Jogged, Straight)
Ratsnest points : Ratsnest의표시방법지정(Endpoint 또는 Pin to Pin)

Display Tab  - 화면출력/표시설정
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Display Tab
Enhanced Display Modes – 화면표시설정

Display plated holes : 도금된패드의홀을표시
Display non-plated holes : 도금되지않은패드의홀을표시
Filled pads : 패드의속을색으로채움
Connect line endcaps : 화면에보이는 Cline의꺾임을 Round 
형태로표시
Thermal pads : Negative Plane 상의 Thermal Relief를화면에표시
Bus rats : BUS_NAME 속성이부여된 Net을 Bus형태로묶어서
표시
Waived DRCs : 화면상에 Waived DRC Error 표시

Drill Hole
Filled Pads

- Design Parameters - / Display Tab
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Display Tab
Grids
그리드(Grid) 설정을켜고끄거나, 각 Layer 
별그리드간격을조정한다.
Offset 설정을통하여그리드위치를원점
기준이아닌다른위치로둘수있다.

- Design Parameters - / Display Tab - Grid

x0
y0 8 9 8

9

8

8

x1 x2 x3

y1

y2

y3

Grid 사용형식

부도층 Layer
(Silk, Soldermask…)

동박 Layer
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Design Tab
Command Parameters

User Unit : 치수설정
Size : 용지설정
Accuracy : 소수점자릿수
Extents

Left X, Lower Y : 도면창구석좌표값
Width, Height : 용지크기

Move Origin : 원점이동(Extents 에반영)
Drawing Type : 파일작업유형

Board, Package Symbol, Shape, Etc..

- Design Parameters - / Design Tab

Micron,
Millimeter,
Centimeter

Mil, Inch
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Design Tab
Line lock – 배선꺾임설정

Lock direction : 배선각지정(Off - 자유각, 45, 90)
Lock mode : 꺾임형태지정(Line, Arc)
Minimum radius : Arc의최소반경지정(기본값 0)
Fixed 45 Length : 45도배선중, 꺾임을고정할경우, 꺾인배선의길이지정
Fixed radius : Arc 배선중, 반경을고정할경우, Arc 배선의반경지정
Tangent : Add - Line 작업에서 Arc의진행방향설정

Symbol – 부품속성설정
Angle : 객체회전각 default 값지정(시계방향)
Mirror : 반시계방향회전설정
Default symbol height : 부품높이기본값지정
(DRC 부품높이제한)

Tangent 설정 Tangent 해제

- Design Parameters - / Design Tab
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- Design Parameters - / Text Tab

Design Tab
Size – 문자설정

Justification : 문자정렬방식 (왼쪽, 가운데, 오른쪽)
Parameter block : 문자설정 Set default 값지정 (Text Setup – Text Blk)
Text marker size : Text의내용이없을경우표시될삼각형 Marker의크기지정

Text Marker

Note
PCB Editor에서는 Text Size를하나의 Set으로묶어 Text Block 
이라는이름으로관리하며, 각각의 Text의크기는개별설정을하는
것이아니라, Text Block의일련번호를부여하여각 Block에서
지정된크기를해당 Text 객체에적용한다.
내용없이 Text를유지하거나, Text Line을개행할경우 Text 
Marker로해당 Text의내용이비어있음을알리며, 추후
Edit > Text 명령을통해내용을수정할수있다.
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- Design Parameters - / Text Tab
- Setup->Grids

- Text Setup -
Text Blk = Text Block 일련번호

Width = 글자폭

Height = 글자높이

Line Space = 줄(행) 간격
Photo Width = 선폭 (0으로지정될경우화면상에 1px로표시)
Char Space = 문자간격

Reset = (저장전일경우)저장된값으로복구

Add = Text Block Set 추가
Compact = 현재사용하지않는 Text Block Set 제거
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- Design Parameters - / Shapes Tab

Shape Tab
Edit global dynamic shape parameters
Command Parameters – Shape 속성설정

Global Dynamic Shape Parameters : Dynamic Shape를위한
공통설정
Static Shape Parameters : Static Shape를위한공통설정
Split Plane Parameters : Split Plane의 Fill style 설정

Edit static shape parameters
Shape Void에대한속성설정

Shape 작업후 Constraint의설정값, 현화면에서의더해지는
값으로 Void처리설정.

Edit split parameters
Shape Type 대한설정

Shape Fill Type의설정
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- Design Parameters - / Route Tab

Route Tab / Add Connect folder
Add Connect Parameters – Control Panel 표시여부및 Default 값
설정
Miter : 배선모따기설정
Line Width : 배선폭설정
Bubble : 배선충돌(Short)시처리방법설정
Shove vias : 배선충돌방지를위한비아이동허용
Gridless : 그리드무시
Clip dangling clines : 결선되지않은패턴끝점의이동여부설정
Smooth : 배선변형정도설정
Snap to connect point : 배선 – Pin 자석기능사용
Replace etch : 중복되는배선제거 (배선교체)

Control Panel
표시여부설정
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Route Tab / Delay Tune folder
Delay Tune Parameters – Delay Tune 관련 default 값설정

Accordion : 아코디언형식배선
Sawtooth : 톱니형식배선
Trombone : 트롬본형식배선
Centered : 시작, 종료점을중앙으로위치
Gap : Cline간간격
(nx space 또는 nx width 또는 mm/mil 단위값입력)
Corners : 꺾임방식설정
Miter size : (45도배선에서)모따기각설정
Allow DRCs : Online DRC를따름

- Design Parameters - / Route Tab
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Route Tab / Edit Vertex folder
Edit Vertex Parameters

Bubble : 배선충돌(Short)시처리방법설정
Shove vias : 배선충돌방지를위한비아이동허용
Clip dangling connect lines : 결선되지않은패턴끝점의이동여부
설정
Smooth : 배선변형정도설정
Allow DRCs :
Allow gridless :

- Design Parameters - / Route Tab
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Route Tab / Slide folder
Slide Parameters

Corners : 배선각설정
Max 45 len : 45도배선각제한길이설정
Bubble : 배선충돌(Short)시처리방법설정
Shove vias : 배선충돌방지를위한비아이동허용
Clip dangling connect lines : 결선되지않은패턴끝점의이동
여부설정
Smooth : 배선변형정도설정
Allow DRCs :
Gridless : 
Add at max :
Vias with segments :
Ts with segments :

- Design Parameters - / Route Tab
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Route Tab / Gloss folder
Gloss Parameters

Line and via cleanup
Via eliminate
Line smoothing
Center line between pads
Improve line entry into pads
Line fattening
Convert corner to arc
Pad and T connection fillet
Dielectric generation

- Design Parameters - / Route Tab
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Route Tab / Create Fanout folder
Create Fanout Parameters

Include Unassigned Pins
Include All same net pins
Start and End Layers
Via Structure
Via Direction
Override Line width
Pin-via space
Min Channel Space
Curve
Curve Radius

- Design Parameters - / Route Tab
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- Design Parameters - / Mfg Tab

Manufacturing Applications Tab
Command Parameters

Testprep : Testpoint 생성설정
Thieving : Thieving 생성설정
Silkscreen : Autosilk subclass 생성설정
Drafting : Dimension 설정
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- Status -

Status Tab
Symbols and nets

Unplaced symbols : 배치되지않은부품의수
Unrouted nets : 완료되지않은배선의수

Shapes
Isolated shapes : 결선되지않은 Shape의수
(Shape Island)
Unassigned shapes : 연결될 Net이지정되지않은 Shape의수
Out of date shapes : 설정변경이필요한 Shape의수
(Shape설정의 Smooth option 참고)
Dynamic fill : Shape의 Fill Mode 설정
(Global Dynamic Parameter 참고)

DRCs
DRC errors : DRC에러현황표시(빨강<노랑<녹색)
Update DRC : DRC 갱신
Waived DRC errors : Waived DRC Error의개수표시
On-Line DRC : Online DRC 실행설정

Note
Status box Color - Green : 모든객체정상, Yellow : 일부객체정상, Red : 정상객체없음
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- Display 설정 - / 환경 Group, Class, Subclass

기타 화면 구성요소Display

열 해석 등고선 구성요소Analysis

기판 내, 배치/배선의 허용/금지 영역Areas (Keep In, Keep Out)

공정 및 도면 열람용 정보 구성요소Manufacturing

부품 정보 (부품번호, 유형..)Components

보드 및 부품 구성요소Geometry

동판 구성요소Stack-Up

설 명Group
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Outline, Title_Block, Title_Data, Revision_Block, 
Revision_Data

Drawing Format

Photoplot_Outline, No_Gloss_All, No_Gloss_Top, 
No_Gloss_Bottom, No_Gloss_Internal, Ncdrill_Legend, 
Ncdrill_Figure, Probe_Top, Probe_Bottom, Autosilk_Top, 
Autosilk_Bottom, No_Probe_Top, No_Probe_Bottom

Manufacturing

Assembly_Top, Assembly_Bottom, Place_Bound_Top, 
Place_Bound_Bottom, Pin_Number, Pad_Stack_Name, 
Silkscreen_Top, Silkscreen_Bottom, Body_Center, 
Soldermask_Top, Soldermask_Bottom, Display_Top, 
Display_Bottom, Modules, Dfa_Bound_Top, 
Dfa_Bound_Bottom, Pastemask_Top, Pastemask_Bottom

Package 
Geometry

Outline, Plating_Bar, Assembly Notes, Tooling_Corners, 
Dimension, Place_Grid_Top, Place_Grid_Bottom, Top_Room, 
Bottom_Room, Both_Rooms, Switch_Area_Top, 
Switch_Area_Bottom, Silkscreen_Top, Silkscreen_Bottom, 
Assembly_Detail, Soldermask_Top, Soldermask_Bottom, 
Off_Grid_Area, Wb_Guide_Line

Board GeometryGeometry

SUBCLASSCLASSGROUP

- Display 설정 - / 환경 Group, Class, Subclass
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Non-Conductor : Soldermask_Top, 
Soldermask_Bottom, Pastemask_Top, 
Pastemask_Bottom, Filmmask_top, 
Filmmask_bottom, Through All, Package_Top, 
Package_Bottom

Pin, Via, DRC,
Etch, Anti Etch, Boundary

Stack-up / 
Non-Conductor

존재하지않음.Grids, Ratsnest(Top, 
Bottom, Thru), Temp 
Highlight, Perm Highlight, 
Background

Display

Top, Bottom, Through AllRoute Ko, Via Ko, Package 
Ko, Package Ki, Route Ki
Constraints Region

Areas

Assembly_Top, Assembly_Bottom, Silkscreen_Top, 
Silkscreen_Bottom, Display_Top, Display_Bottom

Comp Value, Dev Type, Ref 
Des, Tolerance,
User Part

Components

Top, GND, VCC, Inner, BottomPin, Via, DRC,
Etch, Anti Etch, Boundary

Stack-up /
Conductor

SubclassClassGroup

Note
• 15.X > 16.x 변경사항 : Board Geometry / Constraint Area(Subclass) > Areas / Constraint 

Region(Class)

- Display 설정 - / 환경 Group, Class, Subclass
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- Display 설정 - / Display 설정창(192 Color)

Note
각 Group / Class / Subclass / 객체별로표시색상을
변경한다.
작업중사용되는 Subclass의수는한정되어있다.
View -> Color view Save 를이용하여색상 style을
따로저장/관리할수있다.

Subclass 보이기/숨기기

Color Palette

Group
Folder

Subclass

Subclass 색상변경

Subclass 모두켜기 / 모두끄기
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- Display 설정 - / Display 설정창(192 Color)

Shadow Mode
화면을어둡게하여, 선택한객체를강조한다.

OpenGL
OpenGL Engine을이용한객체투명도설정

Display Group
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- Display 설정 - / Display 설정창(24 Color)

Group

Class

Subclass

Group 선택 Subclass 모두켜기 / 모두끄기

팔레트설정저장 / 읽기 사용자지정색만들기

Note
각 Group / Class / 
Subclass / 객체
별로표시색상을
변경한다.
작업중사용되는
Subclass의수는
한정되어있다.
View -> Color view 
Save 를이용하여색상
style을따로저장 / 
관리할수있다.

Command : 
color
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Shadow Mode
화면을어둡게하고선택한객체를강조한다.

Command : 
color

- Display 설정 - / Display 설정창(24 Color)
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- Display 설정 - / 색상우선순위
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- Subclass ETCH 설정 / Layer 설정
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열전도성 점착제Thermal Glue Coating

광섬유(광 도파관)Optical Wave Guide

Wire (Cable, Etc.)Multi Wire

Wire (Cable, Etc.)Micro Wire

Wire (Package)Bonding Wire

전도체 (Plane Layer)Plane

부도체Dielectric

부도체Crossover

전도체Conductor

Layer Type

- Subclass ETCH 설정 / Layer 설정
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동박 (전도층)
PLATED_COPPER_F
OIL

동박 (전도층)COPPER

Layer간 절연층 (Flexible PCB)POLYMIDE_FILM

Layer간 절연층
(Poly Tetra Fluor Ethylene)

PTFE

Layer간 절연층 (시안산염 수지)CYANATE_ESTER_S

Layer간 절연층 (시안산염 수지)CYANATE_ESTER_E

Layer간 절연층 (BT Epoxy)BT_EPOXY

Layer간 절연층 (Polymide)POLYMIDE

Layer간 절연층 (4Functonal Epoxy)TETRAFUNCTIONAL

Layer간 절연층 (Glass/Epoxy)FR-4

불연재 코팅층 (Mask)CONFORMAL_COAT

외부영역 (공기중)AIR

Material (재질설정)

- Subclass ETCH 설정 / Layer 설정
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반전색상 인쇄Negative

정상색상 인쇄Positive

DRC as Photo Film Type

Layer 이름 입력Etch Subclass Name

- Subclass ETCH 설정 / Layer 설정
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개요 : 중대형 PCB Artwork의분할작업을위한관리옵션

Project Manager

Partition Designer

Partition Designer

Partition Designer

작업영역분할 작업결과취합

작업완료

Project Manager

작업개념도

환경설정

- Partitioning option -
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Line mode
(Default) Rectangle Add mode Shape Add mode

• 작업영역지정후, Partition_숫자식으로태그자동할당.

• 영역중복가능하며, 중복여부는 Report로확인가능.

• Draw mode

– Line mode : 금을긋는식으로작업영역지정

– Rectangle mode : 사각형으로작업영역지정

– Shape mode : 다각형으로작업영역지정

- Partitioning option - / 작업영역분할및할당

환경설정



61

Allegro PCB Editor

Guide Port setup process

• 작업영역간배선위치의
어긋남을막기위한 Ratsnest 
배선가이드설정

• 위치조정에필요한객체선택시, 
경계선에걸쳐진 Ratsnest를클릭

- Partitioning option - / Guide ports

환경설정
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Import : 분할작업된파일(dpf) import
Export : 분할영역을파일로 export
Report : 파티션내상태정보출력
Refresh : Master design 내용갱신

ViewLog : import/export/제거관련작업내역
(Workflow_manager.log)
Mail : 메일전송 Form 호출
Delete : 파티션삭제
Retract : 변경사항발생에따른파티션적용
취소 (해당파티션은 import 될수없음)

버튼설명

메모기입창

파티션정보표시창

- Partitioning option - / Workflow manager

환경설정
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Pa
rt

iti
on

_3

Partition_2

작업영역분할지정

Partition File Export

Partition 경계에위치한
Ratsnest 위치조정

Partition File 확인및전달

- Partitioning option - / 작업영역할당(Project manager)

환경설정
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Partition File Open

PCB Artwork
(할당된 영역만 편집 가능) 작업 완료 및 작업파일 전달

- Partitioning option - / 할당영역작업(Sub designer)

환경설정
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Partition File Import

결과확인및작업마무리
(Gloss, Create Gerber, Etc.)

• Partition File의 Progress는 Partition 
File(*.dpf)에서 Partition Designer가작업의완료
여부에따라, 진행상태를표기하며, Project 
Manager는진행상태의확인만가능하다.

• Partition으로할당된파일(*.dpf)은 Gloss 및
Manufacture 관련작업을할수없다.
따라서, PCB 부품배치/배선이후모든정리
작업은 Project Manager가내용을취합한
상태에서진행한다.

- Partitioning option - / 작업취합(Project manager)

환경설정
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Allegro 16.0 이후, 기존에별도로관리한
Physical / Spacing 항목을 Constraint 
Manager로의통합으로단일 Rule 관리
체계로재편됨

개요및사용목적 : DRC 기반의 PCB 작업을위한, Board 상물리적 / 전기적 Rule의설정, 관리 Tool

PCB Editor Constraint Manager

Rule 정의

Rule기반 작업

Board Data(Net, Pin) 전송

Constraint Rule 반영(DRC)

작업개요

분류 Rule
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- DRC Marker -

Constraints 설정은 Design Rules Check를위한설정이며, Constraints Rules를위반하는부분에 DRC 
Marker가표시된다.
Show Element  기능으로해당 DRC Marker의오류내용을확인하거나, Report 기능을사용하여
오류내용을확인할수있다.
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- Menu description -

사용목적
Board 내구성요소(배선, 핀, 비아등)의물리적/전기적 Rule을설정

메뉴설명
Modes : DRC mode 설정창호출
Electrical : Constraint Manager 호출 – Electrical rules 활성화
Physical : Constraint Manager 호출 – Physical rules 활성화
Spacing : Constraint Manager 호출 – Spacing rules 활성화
Physical Net Overrides : Net 속성정의창호출 – Physical 속성
Spacing Net Overrides : Net 속성정의창호출 – Spacing 속성
DFA Constraint Spreadsheet : DFA Constraint Dialog 호출
Constraint Manager : Constraint Manager 호출

Note
DFA Constraint Manager : 부품실장을고려한, Package 간격 Rule 기준부품배치관리기능
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• Constraint Set Mapping을이용한설정 : Constraint Rule Set 지정후, 배선별 Rule Set 지정

- 진행과정 -

• 각항목직접설정 : 각각의배선별 Rule 설정
(Physical / Spacing / Electrical rules)
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- Rules Description -

Electrical - 전기적특성 rule 설정
• Signal Integrity

• Reflection - Overshoot 임계값설정
• Edge Distortions - 파형왜곡 rule 설정
• Estimated xtalk
• Simulated xtalk
• SSN - 스위칭노이즈 rule 설정

• Timing
• Switch/Settle Delays - 스위칭안정시간 rule 설정
• Setup/Hold - 신호의 Setup/Hold time rule 설정

• Routing
• Wiring - Ratsnest 구성방법설정

(Star, Daisy chain, etc..)
• Impedance - 배선임피던스 rule 설정
• Min/Max Propergation Delay - Delay rule 설정

(단일배선)
• Total Etch Length - 배선길이설정
• Differential Pair
• Relative Propergation Delay - Delay rule 설정

(여러배선의 Delay 조정/일치)

Physical - 배선폭설정

• 구분 - Rule 적용범위
• Layer - 레이어단위설정
• Region - 레이어+영역단위설정

Spacing - 배선간격설정

• 구분 - Rule 적용범위
• Layer - 레이어단위설정
• Region - 레이어+영역단위설정
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- Constraint Modes -

Electrical - 전기적 Rule의 DRC 적용여부결정

• Stub length/Net Schedule
• Max via count - 최대비아수

• Max exposed length
• Propagation delay - 신호전달지연

• Relative propagation delay - 복수배선의신호 Timing 일치
• Max parellel
• Impedance - 배선임피던스

• Total etch length - 배선총길이

• All Differential pair checks - Diff pair 배선 Rule
• Max xtalk
• Max peak xtalk
• Layer sets
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- Constraint Modes -

Physical - 배선폭등, 물리적 Rule의 DRC 적용여부결정

• Min line width - 최소배선폭

• Min neck width - Neck mode 배선시배선폭

• Max neck length - Neck mode  배선시최대배선길이

• Max line width - 최대배선폭

• Allow on etch subclass - 레이어배선여부

• T junctions - 접합점온도(열해석)
• Min BB via stagger - BB Via 엇갈림배치최소값

• Max BB via stagger - BB Via 엇갈림배치최대값

• Pad/Pad direct connect - 패드간직접연결
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- Constraint Modes -

Spacing - 배선, Pad 등동박간격 rule의 DRC 적용여부결정

• Pin
• Line
• Via
• Shape
• Thru xxx - Thru-hole type pad
• Smd xxx - Surface mount type pad
• Bond finger - Bonding pad
• B/B Via - Blind / Buried via
• Min BB Via Gap - BB 비아간최소간격
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- DFA(Design For Assembly) - : Package 단위, 부품이격
설정

완성된 PCB 기판에 부품을 실장할 때, 수동삽입 또는 공정형태의 자동삽입으로 진행할 수 있다. 부품
실장시, Package type에 따라 부품간 이격을 최소 얼마 이상의 값으로 부여해야 하는 경우가 있는데 이 때, 
DFA Constraint를 통해 부품 실장을 고려한 PCB Design을 진행할 수 있다.

Allegro PCB Editor의 Constraint Manager가 패드와 동박 패턴간 이격 및 Package symbol의 Boundary에
대한 Rule을 관리하는 반면에, DFA는 부품 실장을 위한 Package symbol 이격을 관리하는 차이가 있다.

Package symbol boundary에 의한 DRC와는 다르다.
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진행 순서

1. Browse for symbols : DFA Rule을 적용할
Package symbol 지정

2. Package간 Symbol 간격을 Spreadsheet에서
입력하여 지정하거나

3. Default 항목에 값을 입력하고 셀을 블록으로
선택한 후, Apply selected cells 버튼을
클릭하여 일괄적으로 지정

4. Constraints 설정을 On으로 선택하여 Online-
DRC 상태를 활성화

DFA Rule Spreadsheet window

1

2 3

4
단위설정

- DFA Constraint 설정 - : 각 Package type 별 Rule 정의
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- DFA 관련 Preference 설정 -

Note

• dfa_pause_level : 부품 이동시 DFA Rule을 위반할 경우 부품 이동을 순간적으로 멈춤
0~3 까지 선택 가능하며, 0은 pause 없음, 3은 가장 강한 pause, 기본값 1

• display_nodfa_drc_marks : DFA 원형 Marker에 같이 표시되는 DRC Marker 제거

부품 이동시 Delay됨
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- DFx Check(Batch DRC) - : Board내부품배치상태의일괄검증

Note
• Constraint Setup : Check 항목 지정 및 설정

• Explore Violations : 오류 항목 탐색

• Report : Check 결과 내용 확인
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Xnet

Constraint Rules

Allegro DB 내부에서는수동소자나 Connector가추가된배선의경우, 수동소자양단을기준으로각배선을
독립적인객체로관리한다.
필요할경우, Constraint Manager에서단일배선으로묶어관리할수있으며, 이를 Xnet이라는이름으로
정의한다.

- Xnet 개요 -

R11
1kNet Net
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PCB SI 환경설정호출

또는

Resistor Model 정의 Xnet 적용여부확인

(Constraint Manager)

- Xnet 정의 -
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Xnet은별도의설정이존재하지않으며, Passive Part modeling에의해자동으로설정됨

2핀 Resistor는 Auto Setup을이용한자동설정권장.
R 판별여부는 Setup Advisor의 Device Setup 단계에서 Refdes 문자로결정

Resistor Array 설정시, Auto Setup으로 Model 정의되지않을경우, Edit Model 클릭하여 Pin 
Connection 설정을직접추가

- Xnet 정의 - / Resistor Model 정의
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- 부품배치 - / Place Manual

부품은알파벳순서로정렬되어있다.
배치를원하는부품을모두체크하면 Placement 
목록에나열된순서대로도면상에배치된다.
여러개의부품을체크할경우알파벳순서로부품을
배치한다.

Note
OK 버튼 : 작업종료
Hide 버튼 : Placement창최소화
Brd File 내부의부품표시
(Components by refdes)
라이브러리의모든부품 표시
(Package symbols)
사용자정의부품을사용하려면, 
반드시 Preference에저장경로가
명시되어야한다.
부품이동은 Place Manual -H를
사용한다.
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- 부품배치 - / Quick Place

선택한속성을갖는부품을배치
Room 영역에속한부품을배치
특정번호의부품을배치
특정이름의 Net과연결된부품을배치
회로도면페이지단위로부품을배치
모든부품을배치
부품번호범위에속하는부품을배치
부품배치위치를결정
배치된 / 배치되지않은부품수표시

Note
Manual Place와달리 Quick Place는미리설정된 Rule에의해원하는
부품을원하는영역에일괄적으로배치한다.
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- 부품배치 - / Quick Place - all components

모든부품을배치

Note
Edge - 부품이배치될보드외곽주변의위치를지정한다.
Board Side , Top / Bottom - 부품이실장될방향을결정한다.
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- 부품배치 - / Quick Place - by room

Room 영역에속한부품을배치

Note
특정위치에배치될부품들의 Room 속성에 Room Name을부여하고, 
Board에동일한 Room Name을갖는 Room Outline을사용하여
배치영역을지정한다.

진행 : 부품 Room 속성부여 -> Room 영역지정 -> 부품배치
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- 부품배치 - / Quick Place - by room

Room Property Setting (Allegro PCB Editor 에서설정할경우)
부품선택 - 직접선택하거나, Control Panel을통한선택
Property 선택
Property Value 입력 - Room Name 입력
Room Property는 Capture에서회로작업중에도입력가능
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Room Property Setting (Capture / DE CIS 에서설정할경우)
부품선택 - Edit Properties
각부품의 Room Property Value (Room Name) 입력
Property Value 입력 - Room Name 입력

- 부품배치 - / Quick Place - by room
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Create Room Outline
Create

Draw Rectangle - 마우스클릭으로영역그리기(사각형)
Place Rectangle - 크기를지정하여배치(사각형)
Draw Polygon - 마우스클릭으로영역그리기(자유도형)

Edit - 이미그려진영역수정
Move - 이미그려진영역이동
Delete - 이미그려진영역삭제

- 부품배치 - / Quick Place - by room
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Place by room
배치방법선택 - Place by room
배치지역선택 - Room Name
배치부분선택 - Top 또는 Bottom
Place 클릭
배치를취소하고싶으면 Unplace 클릭

- 부품배치 - / Quick Place - by room
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- 배선 - / Button

Rats All

Add 
Connect

UnRats 
All

Slide
Custom 
Smooth

Edit
Vertex

Create
Fanout

Delay 
Tune

UnRats All - 작업창의모든 Ratsnest를숨김
Rats All - 작업창의모든 Ratsnest를표시
Add Connect - 배선
Slide - Segment(선) 단위편집
Delay Tune - 배선길이조정(Delay)
(Performance Option)
Custom Smooth - 배선정리
Edit Vertex - 배선편집 / 조정
Create Fanout - Fanout 생성(by Pick)
Spread Between Voids - Pad 내 Void 침범배선교정

Note
Ratsnest - 결선되지않은 Net
Cline - Connection line(패턴)
Manhattan Length - Connection 간최단거리
(또는패턴이아닌 Ratsnest 길이)

Spread
Between

Voids
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- 배선 - / Rats, UnRats

UnRats 
All

Rats All
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- 배선 - / Add Connect - Control

활성 Layer
대체 Layer (Via를배치하면 Act와 Alt가서로바뀐다.)
Via로사용할 Padstack 선택
Net name 정보
배선각지정(45도, 90도, 자유각도)
배선각이 45도인경우, 꺾인배선의크기지정
배선폭지정
패턴간충돌을막기위한배선우회

Shove - 기존패턴의배선우회
Hug - 현재작업중인패턴의배선우회

- Gridless : 그리드를타지않는다. (DRC에맞춰배선)
_ Snap to Connect Point : 그리드가맞지않아도핀에배선을연결
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Via 밀어내기허용 / 금지
Grid를무시한배선작업허용 / 금지
결선되지않은패턴의끝점을이동할수있게허용 / 금지

Note
배선중, Layer 변경은 Via 추가 -> Layer 이동의순서로작업한다.
배선의 Layer 이동을빠르게하기를원한다면아래와같이한다.

Via 배치 - 마우스더블클릭
Alt Layer가아닌다른 Layer로이동 - 키보드 + 또는 -
(Act Layer가변경된다.)

- 배선 - / Add Connect - Control
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gridded

gridless

Off

Shove 
preferred

Hug 
preferred
Hug Only

Bubble의최소간격값은
Online DRC의설정을기준
값으로따른다.

- 배선 - / Add Connect - Control
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Off
Minimal
Full

Smooth - 형태가바뀌는배선이
Smoothing 되는정도를지정
Snap to connect point - 배선끝이
Pad에쉽게붙도록설정
Replace etch - 중복되는패턴을
제거

- 배선 - / Add Connect - Control
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- 배선 - / Add Connect - Via

thru-hole via

blind via

buried via

Via
배선중 Via 추가는 Add Via 메뉴를
이용하거나, 마우스더블클릭으로
배치한다.
필요하면여러종류의 Via Set를
구성하여그때그때바꿔가며
사용한다.

Note
Constraint Setting의 Via List에서
사용할 Via-Hole을추가/제거할수
있다.
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- 배선 - / Slide

DRC Rule을따르도록설정
Corner 또는 Arc의최대값을설정하고, 그값을초과할경우새로운
Corner나 Arc를생성
Segment를이동할때, Via도같이이동하게끔설정또는, 해제
T자배선전체를하나의단위로이동하게끔설정또는, 해제

조정
전

조정후
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- 배선 - / Edit Vertex
Vertex 생성Vertex 생성

Vertex 제거
또는+
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Edit > Delete  

Route > Slide

Edit > Change (width)

1st Pick 2nd Pick

Done

1st Pick

2nd Pick

Done

배선및정리

- 배선 - / Edit Vertex
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- 배선 - / Custom Smooth

Note
Gloss의 Line 
Smoothing기능을
사용하여일괄적으로
정리할수있다.
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- Gloss -

Gloss의적용범위지정
Design - Board 전체
Room - Room 영역
Window - 지정영역 (실행후, 적용할영역지정)
Highlight - 선택(Highlight)부분
(Highlight로객체선택후, 실행)
Gloss영역의객체 List 출력

Note
Fillet = Tear Drop
Gloss로부터특정부분을보호해야할경우
아래속성또는영역을지정한다.

속성(Property) : NO_GLOSS, FIXED
영역(Subclass) : NO_GLOSS_XXX
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- Shape - / Add, Edit

Add Shape

Edit 
Shape
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- Shape - / Print Image

Film

PCB Editor

Negative plane Positive plane Note

• Positive Plane
• Shape를사용하여형성한다.
• 동판으로형성되는부분이
채색된다.

• 배선, 연결정보가변경될경우
Shape 내역을갱신해야한다.

• 전원층분리작업이간단하다.

• Negative Plane
• Shape를쓰지않고자동적으로
형성된다.

• 동판으로형성되지않는부분이
채색된다.

• 다른구성요소의변경내역이
즉시반영된다.

• Flash symbol을미리제작해
두어야한다.

• 전원층분리작업이간단하지
않다.
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VS

Negative Shape Positive Shape

Positive 출력

Negative 출력

배선및정리

- Shape - / Print Image
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- Shape - / Add, Edit

Shape 외곽조정

Shape 속성조정

Cross-Hatch Solid

- Shape -/ Parameters 참고
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Shape 외곽조정

두개이상의 Shape가특정위치에서
겹칠경우우선순위(Priority)를
올려서그림과같이영역을할당한다.

더높은우선순위(Priority)의 Shape 더높은우선순위(Priority)의 Shape

배선및정리

- Shape - / Add, Edit
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Shape >Shape >

Polygon
Rectangular
Circular

Polygon
Rectangular
Circular

2

1

3

1 - Shape를배치할 Subclass 지정
2 - Shape Fill type 지정
3 - Shape에접속할 Net 지정

배선및정리

- Shape - / Control
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• Shape Fill Style : Hatch/Solid 등의 Fill Style 설정
• Void Control : 최적화된출력형상을위한 Gerber 유형별 Shape Void 출력선택
• Clearances : Line Constraint Rule 기반의 Shape / Pattern간이격거리설정
• Thermal relief : Thermal Relief 형성방법(방향및연결 Line 수)의세부설정

Shape Fill Void Control Clearances Thermal Relief

Solid

Hatch

Pin Void

Line Void

배선및정리

- Shape - / Parameters
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Update to Smooth : 현재 Dynamic fill 
mode가 Rough 또는 Disable로설정된
모든 Dynamic Shape의 fill 모드를
Smooth로변경(Void 및 Thermal 연결
내역도같이갱신)
Out of date shapes : 전체 Shape 중, 
Dynamic fill mode가 Rough 또는
Disable로설정되어제대로묘사되지
않는 Shape의수

Dynamic fill - Shape의채색방법선택
Smooth - 고품질(Artwork film quality 
output)의 Shape Fill mode
Rough - 세부적연결및묘사를간략화한
mode
(Shape 연결, Void 내역갱신최소화)
Disabled - Shape의형태를대략적으로
표시, 작업규모가클경우사용
(Shape 연결, Void 내역갱신하지않음)

Copper Plot을위한설정

배선및정리

- Shape - / Parameters
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Snap on

Snap off

Artwork format - Shape 최적화를위한출력
형식선택
Minimum aperture for artwork fill - shape fill을
위한최소 aperture 크기
Minimum aperture for gap width - shape fill을
위한최소 aperture 크기(와같은말)
Suppress shapes less than.. - 설정된값보다
작은크기의 Shape 제거

배선및정리

- Shape - / Parameters
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Allegro PCB Editor배선및정리

- Shape - / Parameters
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Allegro PCB Editor배선및정리

- Shape - / Parameters
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• Shape Void : 5가지 Void 유형선택 – Element, Polygon, Rectangle, Circle, Boundary

Shape Merge 전 Shape Merge 후

Shape Void 전 Shape Void 후

Shape Merge : PCB Editor의 Draw기능으로제작하기어려운형태의 Shape를부분적으로제작하여통합

배선및정리

- Shape - / Merge & Void
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신호왜곡방지를위한, Pin Void / Signal trace간위치겹침여부의표시

Pattern

Void

Spread Between Voids 기능사용Slide 기능으로직접교정

또는

배선및정리

- SOV (Segment Over Void) -
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Pad간 Trace 간격교정

1

2

3

4

Copper 보전또는 Signal trace의전류전달안정성확보를위해, Segment Over Void
기능을통해확인한 Void영역침범패턴의간격을교정

• 메뉴선택후, 순서대로 Pad를클릭하여교정작업진행
• Pad의 Void Clearance값을바탕으로이격하며, 이격간격을
넓히려면제어판의 Clearance 항목에값을지정후작업.

교정전 교정후

배선및정리

- Spread Between Voids -
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- Route Automatic - / Router Setup Tab

미리설정된 do File을사용하여자동배선진행

2

3

5

6 1. Strategy : 작업방법결정

2. Limit via creation : 비아생성금지

3. Limit wraparrounds : 핀끝을둘러싸는형태의배선금지

4. Protect existing routes : 기존배선형상의변형금지

5. Turbo Stager : 핀/비아주변의배선을허용하여배선성능
및효율향상

6. Enable diagonal routing : 대각(45도) 배선허용

7.해당 Layer 배선허용

8. Layer(Subclass) 명칭

9.배선방향 – Horizontal 가로위주 / Vertical 세로위주

10.Protect : 기존배선보호

7 8 9 10

1

4

배선및정리
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1. Preroute and route : 작업과정정의

1. Check : 해당작업진행

2. Pass type : 작업내용정의

3. Passes : 작업횟수설정

4. Start : 버릴작업횟수설정

2. Post Route : 배선후, 마무리작업

1. Critic : 배선굴곡/계단제거
(Clean – 재배선 VS Critic – 굴곡만교정)

2. Filter routing passes : 중복/겹침배선제거

3. Center wires : Pin 사이를지나는배선위치를각 Pin 
가운데로교정

4. Spread wires : 배선-배선, 배선-Pad 간간격추가

5. Miter Corners : 직각배선모따기

6. Delete conflicts : 중복및 Highspeed rule을위반한
배선제거

1

2

- Route Automatic - / Routing Passes Tab

배선및정리
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1. Params… : Passtype 별 Parameter 설정

2. Clear : 정의된진행과정삭제

1

2

• Fanout : SMD Pad의 Fanout 생성
• Seed Vias : 일정길이이상의배선을강제로끊고비아
배치

• Bus : Bus 배선
• Clean : 배선비틀림교정

• Testpoint : Testpoint 생성(Pad, Via에 TP 지정)
• Critic : 배선굴곡/계단제거

(Clean – 재배선 VS Critic – 굴곡만교정)
• Filter : 중복, 겹침배선제거

(Filter routing passes와동일)

- Route Automatic - / Routing Passes Tab

배선및정리
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Fanout 설정
• Direction : Fanout시배치될 Via 방향(Component pin 기준)

• Via Location : 배치될 Via 위치(Component outline 기준)

• Maximum Fanout Length : Fanout시최대배선거리

• Enable Radial Wires : 방사형배선진행(APD 전용)

• Fanout Grid : Fanout 배선그리드설정

• Blind/Buried Via Depth : BB Via사용시 Fanout의진행
방향(Layer) 결정

1
2

3
4

5
6

- Route Automatic - / Routing Passes Tab / Params

배선및정리
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Fanout 설정
1. Pin Types : Fanout을진행할 Pin 유형설정

2. Share Within Distance : Share기능이용한공유시최대거리
한도설정(아래항목들의 Global 설정)

3. Share Pins : Same net에해당하는 Thru-Hole Pin을사용하여
Fanout

• Max Share Count : 공유할 SMD Pin 수한도설정

4. Share SMD’s on Way to Via : Same net에해당하는 SMD 
pin끼리 Via까지의패턴경로공유

• Max Share Count : 공유할 SMD Pin 수한도설정

5. Share Vias : Same net에해당하는 SMD pin끼리 Via 공유

• Max Share Count : 공유할 SMD Pin 수한도설정

1

2
3

4

5

- Route Automatic - / Routing Passes Tab / Params

배선및정리
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1. Diagonal Routing : 대각배선설정

2. Othogonal Routing : 직각배선설정

1. Break-up Connection Longer Than : 배선길이최대값
설정(설정길이값이후로는 Via를통해우회하여배선됨)

2. Place Vias Under SMD Component : SMD 부품상에 Via 
배치허용

Bus Routing

Seed Vias

- Route Automatic - / Routing Passes Tab / Params

배선및정리
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Testpoint 설정
1. Testpoint Side : TP를배치할 Layer 지정

2. Testpoint Position : TP 배치관련세부설정

• Center To Center Spacing : 최소 TP간간격(TP 중심점
기준)

• Center To Component Spacing : 부품 Boundary로부터
TP간최소이격거리(TP 중심점기준)

• Component Outline Clearance : 부품 Boundary로부터
TP간최소이격거리(TP 외곽선기준)

• Testpoint X Grid : TP배치시 X축그리드설정

• Testpoint Y Grid : TP배치시 Y축그리드설정

• Maximum Length : Pad, TP간최대거리

3. Pin Use

• Allow Pin Use : 부품핀의 TP 사용을허용

• By Component : 지정된부품의 Pin만 TP 사용을허용

4. Via Padstacks

• Specify Testpoint Vias : 지정된 Via만 TP 사용을허용

1

2

3

4

- Route Automatic - / Routing Passes Tab / Params

배선및정리
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1. Spread시추가이격거리값설정(Global 설정)

2.유형별추가이격거리값설정

• Starting > Ending : 시작값에서끝값까지 Spread 작업을
순차적으로진행하며, Ending은값이없을경우 Starting의
값을따름

1

2

Spread Wires

Miter Corners

1. Miter Passes : 작업횟수설정

2. Options

1. Miter Pin and Via Exit : 배선중 Pin, Via Exit 부분 Miter

2. Slant Wrong-way Segments : 배선방향에배치되는배선
Segment를조정

3. Miter T Junctions : T 분기배선을 Miter

4. Miter at Bends : 90도배선을 45도배선으로변환

1

2

- Route Automatic - / Routing Passes Tab / Params

배선및정리
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Elongate (Delay Tune)
1. Meander : 둘러싸는형태로배선늘임

2. Trombone : Trombone 형태로배선늘임

• Minimum Gap : 배선간격

• Maximum Run Length : Segment 단위길이

3. Accordion : 아코디언형태로배선늘임

• Minimum Gap : 배선간격

• Minimum Amplitude : Segment 단위최소길이

• Maximum Amplitude : Segment 단위최대길이

4. Sawtooth : 톱니형태로배선늘임

• Minimum Gap : 배선간격

• Minimum Amplitude : Segment 단위최소길이

• Maximum Amplitude : Segment 단위최대길이

5. Option

• Pattern Stacking : 기존배선에 Elongate 허용

- Route Automatic - / Routing Passes Tab / Params

배선및정리
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• Routing Passes 및 Smart Router의배선범위지정

• Entire Design : 모든배선

• All selected : 선택한모든배선

• All but selected : 선택한배선을제외한모든배선
선택된배선
목록창

배선목록창

1. Grid : Via 및배선그리드설정

2. Fanout : 자동배선중, 필요할경우 Fanout 실행

• 필요할경우, 기존의 Pin 및 Via를 Fanout via로공유

3. Generate Testpoints : 필요할경우, Testpoint 생성기능실행

4.자동배선완료후, Miter corner 실행

1

2

3

4

Selections Tab

Smart Router Tab

- Route Automatic - / Smart Router, Selection Tab

배선및정리
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Rule 설정 배선실행 배선완료및확인

• 개요 : 수동배선을대체하기위한, 물리적/전기적 Rule(Constraints) 부여에의한
자동배선진행과정소개

- Constraint Rule에의한자동배선 -
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진행대상 Net : Ra10 Net Ra10의속성
설정조건
• 대상파일 : cdsrouted.brd
• 대상 Net : Ra10
• Manhattan length : 1460 MIL
• 기준 Rule : 길이(Etch Length)
• 작업방법 : Auto Router 사용
• 배선요구길이 : 2000MIL ~ 2010MIL

배선및정리

- Target net 및조건확인 -
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필요한항목의 DRC를 On으로설정

Etch Length를 예로 들어 설명하므로, Total etch length 
항목의 DRC 만 On으로설정

Note : 기본적으로 PCB Editor에서실시간으로점검하지
않는 Rule이많으며, 필요할경우이를 Constraint 
mode에서실시간으로점검하도록변경함.

배선및정리

- Constraint Rule의 Online DRC 설정 -
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Constraint Manager에서 Rule 설정

Net Properties를선택하여 Constraint Manager 호출

Constraint Manager 호출한후, Net(Ra10) 선택

배선및정리

- Target net의 Constraint Rule 정의 -
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Constraint Manager

Etch 길이최소값정의 : 2000 입력 Etch 길이최대값정의 : 2010 입력

1
2

- 진행과정 -

• 설정할 Rule 항목선택
• Rule을적용할 Net 선택
• Etch 길이최소값정의
• Etch 길이최대값정의

• 전단계에서 DRC를 On
했으므로, 지정한 Rule은
추가설정없이바로적용됨

3 4

배선및정리

- Target net의 Constraint Rule 정의 -



130

Allegro PCB Editor

또는

• Route Automatic : 메뉴창을통한 Board 전체또는특정 Net 자동배선
• Route Net By Pick : 마우스클릭을통한특정 Net 지정자동배선

• Delay Tune은 Router Setup > Params > Elongation Tab에서설정

배선및정리

- Constraint Rule에의한자동배선실행 -



131

Allegro PCB Editor

PCB Editor의 Show Element 기능을이용한확인 Constraint Manager를이용한확인

설정값 현재값 오차(설정값 – 현재값)

배선및정리

- 배선완료여부및배선상태확인 -
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기능개요 : Signal Copper 주변의 Noise 차폐를위한 GND Via 배치편의기능

배선및정리

- Via Array Generator -
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- 항목설명 – (단위 : 사용자설정에따름 > mil 또는 mm)
1. Via Pad간간격
2. Via Array 배치영역지정시, 영역으로부터의이격거리
3. Via 연결배선(주로 GND) 설정
4. Via Array로적용할 Via Pad 지정

Entire Board Bounding 
Box

Shape 
Boundary

3

4

1

2

설정 완료 후, 클릭 > Design 창
내 영역 지정 또는 Shape 선택

배선및정리

- Via Array Generator - / Normal Generator
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1

2

- 항목설명 – (단위 : 사용자설정에따름 > mil 또는 mm)
1. Via Pad간간격
2. Via Array 배치영역지정시, 영역으로부터의이격거리

배선및정리

- Via Array Generator - / Boundary Via Array
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- 항목설명 – (단위 : 사용자설정에따름 > mil 또는 mm)
1. Via Pad 배치지름값절대치 / Shape 대비상대치선택
2. Via Pad 배치지름
3. Via Pad 간간격

2

3

1
Original

Multi-Ring Single-Ring

• 원형 Shape에만 적용 가능

배선및정리

- Via Array Generator - / Circular Via Array
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VS

Single Cline : T 분기와같은패턴에서
선택된부분만 Via Array 배치

Single Cline mode

VS

배선및정리

- Via Array Generator - / Cline Via Array
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VS

2

1

- 항목설명 – (단위 : 사용자설정에따름 > mil 또는 mm)
1. Shape 외곽 / Via Pad 간간격
2. Via Pad 간간격

배선및정리

- Via Array Generator - / Offset Via Array

Shape 주변부(외곽)에 Via Array 
생성
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Tool > Database Check

DRC Update(Batch DRC) 및 Brd file database 내부오류점검

Post Process

- DB Doctor -
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- Create Artwork (Gerber) -

Allegro Design File (.brd)

Smask_bot
Bottom
GND
VCC
Top
Smask_top
SilkTop

SilkBot
Film Control

records

art_param.txt

Parameter file

art_aper.txt

Aperture file

Mylar Film

To photoplotter

Top.art
VCC.art
GND.art
Bottom.art

Gerber files

photoplot.log

Log file

보드설계구성요소 생성되는파일

(vector only)



140

Allegro PCB EditorPost Process

- Create Artwork (Gerber) - / General Parameters

Device Type - 출력 Format 지정
Gerber 6x00 (RS-274D)
Gerber 4x00
(RS-274X, divided aperture file = art_aper.txt)
Gerber RS274X
Barco DPF
MDA

Film size limits - 인쇄영역지정
Coordinate type - 좌표형식지정
Error action - 오류발생시작업방법지정
Format - 인쇄영역의좌표계자릿수지정
Output option - 출력옵션설정
Suppress - 좌표계자릿수설정
Output units - 출력단위지정 (inch, mm)
Scale factor for output - 인쇄물의확대/축소비율지정
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- Create Artwork (Gerber) - / Film Control

Available Films - Film으로출력할부분을지정또는수정
File option - 각 Film의출력관련회전여부, 원점위치, 
인쇄색상형식(정상/반전) 등을설정
Create Artwork - Film File 출력 (*.art)
Check database before artwork - Film file 출력전에 DB 
doctor를이용하여오류확인작업을진행

Note
Films List의항목들은메뉴를통해 Design 창에서바로
확인할수있다.

Drill을제외한나머지 Film은모두 List에추가
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Negative (copper = clear)Positive (copper = black)

Artwork File 출력실행

- Create Artwork (Gerber) - / Film Control
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- Create Artwork (Gerber) - / Aperture wheels

Note
Film 인쇄에사용할점과선의형태를지정한다.
Auto 기능으로 Aperture wheel을자동생성할
수있다.
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Allegro PCB EditorPost Process

- Create Auto Silk -

U12

Autosilk_Top

Pins

Vias

U*
Ref 
Des

Manufacturin
gpackage 

geometry
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Subclass로나누어진각각의구성요소를 Auto 
Silkscreen이라는하나의구성요소(Film)로
통합한다.
부품의실장위치나 Silk Screen 인쇄여부에따라
단면혹은양면으로 Auto silk Subclass를
구성한다.
Subclass내의객체중 DRC Rule을지키지
않은객체는 Auto Silkscreen에포함되지
않는다.

- Create Auto Silk -
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- Create Drill - / Legend (드릴차트)

범례제목

Drill Symbol 사용개수도금여부Drill Size

드릴차트를작업영역에배치하며,
동시에 NC-Drill 1-x Subclass를생성한다.
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- Create Drill - / NC Drill (*.DRL)

필요한파일 출력되는파일

Out-1-4.drl

Log file

nctape.log

NC Drill file

nc_param.txt

Parameter file

nc_tools.txt

Auto tool select
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Allegro PCB EditorPost Process

- Create Detail - / 부분도면확대

Note
보드내특정부분의별도표기를위한확대표시
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총 41개의 Report 형식
Text 형식출력 – 링크가포함된 Html 기반으로출력하여, 객체선택용이
Html Table 형식출력 – 표형식으로출력되어, MS-Excel 등의 Spreadsheet Tool과 100% 
호환

Post Process

- Report -
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text 파일을수정하여사용자정의 Report 생성가능

C:\Cadence\SPB_16.0\share\pcb\text\views
C:\Cadence\OrCAD\16.0\share\pcb\text\views

Report 항목에서선택 Text 파일 Load

Component Report

Post Process

- Report - / Report 설정파일저장경로
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기존 Report 설정파일의예약어를참조하여새로운 Report form 생성
REFDES_SORT : REFDES 기준으로전체출력 Data 정렬
그외(REFDES, COMP_DEVICE_TYPE…) : Allegro 항목예약어

#
# Property of Cadence Design Systems, Inc.  All rights reserved.
#
# $Header: cmp_rep_view.txt.v 1.1 12/01/87 ddd Prealpha
#
# File: cmp_rep_view.txt - Component data extract cmd file for 
# component list report
#
# Revision history:
# (0.10) ddd 12/01/87 Preliminary initial version
#
#
COMPONENT
#
# Extract: refdes(sort), refdes, device_type, value, tolerance,
# package, x, y, angle, mirror.
#

REFDES_SORT
REFDES
COMP_DEVICE_TYPE
COMP_VALUE
COMP_TOL
COMP_PACKAGE
SYM_X
SYM_Y
SYM_ROTATE
SYM_MIRROR
#
# end of cmp_rep_view
#

Post Process

- Report - / Report Customize(ex : Component Report)
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- Padstack - / 유형별 Layer 구성

Through-Hole Padstack
paste

mask

top

Surface-Mount Padstack

top

inner

anti - pad

thermal relief

inner

bottom

mask

drill size

mask
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- Padstack - / Pad Designer

- Parameter Tab -

• Type : 생성가능한 Pad의 Type 지정
- 관통형 / Blind, Buried / 표면실장형

• Internal Layers : Film 출력시내층에서연
결되지않은패드를유지(Fixed)하거나선택
적인제거(Optional)
- Optional은 PCB Editor의 Artwork Film 설
정에의해결정된다.
• Units : 치수단위지정
• Multiple drill : 두개이상의드릴홀지정에
사용

• Drill/Slot hole : 드릴홀크기지정
• Drill/Slot symbol : Drill Chart Symbol 정의
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- Padstack - / Pad Designer

각 Layer를선택하여해당 Layer에
표시할 Pad의크기를정의한다.

- Layer Tab -

• Padstack Layers : 동박및 Mask 
Layer에할당될패드의크기를정의
- Regular Pad
- Thermal Relief
- Anti Pad

• Views : Padstack 미리보기
- Xsection : 옆에서보기
- Top : 위에서보기
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- Padstack - / Pad Designer

regular thermal relief anti - pad
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Allegro PCB EditorSymbol 제작 / 편집

필요하면다른 Layer의설정을복사하거나, 
새로운 Layer를추가/제거한다.

Layer 선택후, 마우스오른쪽버튼메뉴를
사용할수있다.

- Padstack - / Pad Designer
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- Padstack - / Pad 인쇄유형

Regular Pad

Thermal Neg

anti-pad

Shape

Thermal 
Pos

Regular Pad : 원형, 사각형, 타원등의일반적인형태를갖는 Positive Pad
Thermal Relief

Positive : Pin, Via와 Positive Copper를연결하기위한 Pad. Regular Pad에라인을덧
댄형태로표현된다.
Negative : Pin, Via와 Negative Copper를연결하기위한 Flash Type Pad

Anti Pad : Pin, Via를 Copper 주변으로부터분리하기위한빈공간
Shape : 일반적인형태(원형, 사각형, 타원)가아닌, 직접그려사용하는이형 Pad

Note
Thermal Relief의 Positive와 Negative는 Plane Layer에속한 Copper의인쇄형태가
Positive 또는, Negative 여부에따라결정된다.
Shape, Flash를제외한모든 Pad는 Pad Designer 유틸리티로생성할수있다.
Shape, Flash는 PCB Editor 창에서직접 dra 파일로제작하여생성할수있다.
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- Padstack - / Pad Selection Guide

---via

pad; square shape; 55 Milssq55

surface mount pad; 25 x 48 Mils pad size; BOTTOM mounts25_48b

surface mount pad; 25 x 48 Mils pad size; TOP mounts25_48

pin grid arraypga

pad; 50 Mils; square shape; 30 Mil drill sizep50s30

pad; 50 Mils; circle shape; 32 Mil drill sizep50c32

multi-bus connector; 43 Mils; TOP mountm43t

multi-bus connector; 43 Mils; BOTTOM mountm43b

hole; 109 Mils; unplatedh109u

hole; 109 Mils; platedh109p

DescribtionPad Type
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Allegro PCB EditorSymbol 제작 / 편집

- Padstack - / Flash Symbol

.fsm

Note

• Flash Symbol은 Pad의원점이
0,0이므로도면의 Origin을적당히
이동해야정상적으로 Symbol을생성
할수있다.

• ADD -> Flash 를이용하지않고,
직접 Symbol을그려서생성할수
있다.
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- Component Symbol - / Drawing Setting

Symbol 제작 / 편집

Setup > Drawing Size

default datum 0,0

y=0

x=
0

new datum 0,0
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Allegro PCB EditorSymbol 제작 / 편집

(.bsm)(.psm)

package
symbol

mechanical
symbol

(.osm)

format symbol

(.ssm)

shape
symbol

flash
symbol

(.fsm)

- Component Symbol - / Symbol Type
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Assy Ref

Device Type

(별도지정)

Part Ref(Silk, Assy Layer)
Padstacks
(별도지정)

Assembly
Outline

Silkscreen
Outline

Package
Boundary

Minimum/Maximum Package Height

Symbol 제작 / 편집

- Component Symbol - / Symbol 구성요소
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1

3

2

4

5

6

7 8

9

10

11

12

13

14
100

or...

Layout — PinsLayout > Pins

Symbol 제작 / 편집

- Component Symbol - / Pin 배치
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Add > ...

Add > Line

Add > 3pt Arc

Symbol 제작 / 편집

- Component Symbol - / 부품외곽선배치
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Assy Ref

Silk Ref

Device Type
Layout > Labels > 

Device

Layout > Labels > 
Refdes

Symbol 제작 / 편집

- Component Symbol - / Text 배치
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Silk RefSetup > Areas

.050
.150

Assy Ref

Device Type

- Component Symbol - / 영역설정

Symbol 제작 / 편집
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- Component Symbol -

Symbol 제작 / 편집

Note
Symbol 편집후, 저장하면두개의파일이동시에생성된다.

*.dra - 편집가능한원시파일, 부품으로사용하기위해바이너리로컴파일해야한다.
*.psm - 편집불가능한바이너리파일, 부품으로사용할수있다.

원본 dra 파일에이상이있을 경우, psm 파일로컴파일되지않는다.
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outline

package keepin

route keepin

mounting holes

via keepout

chamfer

- Board Symbol - / 외곽영역생성

Symbol 제작 / 편집
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x –1000 0
(여기부터시작)

drawing origin (0,0)
center of mounting hole

ix -850

iy 4500

ix 4100iy -200

ix 850

ix -4100

iy -200

iy -4100

Add > Line

(3800,0)

(0, 4100)

Symbol 제작 / 편집

- Board Symbol - / 외곽영역생성
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Layout > Pins 
또는

Soldermask
(outer circle)

Drill Symbol
(square)

Drill hole 
(inner circle)

Symbol 제작 / 편집

- Board Symbol - / 실장 Hole 설정, 배치
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Dimension > Chamfer
처음

나중

Symbol 제작 / 편집

- Board Symbol - / 모따기(Chamfer)
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Dimension > Linear 
Dim

- Board Symbol - / Dimension

Symbol 제작 / 편집
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… 또는
Setup > Areas…

outline

package keepin
(offset 70 mils)

route keepin
(offset 50 mils)

mounting hole

Edit > Z-Copy

- Board Symbol - / Ki,Ko 영역생성

Symbol 제작 / 편집
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File > Save
.bsm

.dra

+

Symbol 제작 / 편집

- Board Symbol - / 저장

Note
Symbol 편집후, 저장하면두개의파일이
동시에생성된다.

*.dra - 편집가능한원시파일, 부품으로
사용하기위해바이너리로컴파일해야한다.
*.bsm - 편집불가능한바이너리파일, 
부품으로사용할수있다.

원본 dra 파일에이상이있을 경우, psm 
파일로컴파일되지않는다.
Shape의복사에 Z-Copy를사용할수있다.
모든부품은파일로관리되며, User 
Preference에부품의저장경로가반드시
명시되어야해당부품을사용할수있다.
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Allegro PCB EditorAppendix

- PCB Editor Command Index - / File

iff inFile - Import - IFF

idf inFile - Import - IDF

dxf inFile - Import - DXF

load plotFile - Import - IPF

load streamFile - Import - Stream

load photoplotFile - Import - Artwork

netin paramFile - Import - Logic

create symbol (Symbol Editor 전용)File - Create Symbol

save_asFile - Save As

saveFile - Save

opencdFile - Recent Designs

openFile - Open

newFile - New

File

콘솔창 명령메뉴 항목

dxf outFile - Export - DXF

create plotFile - Export - IPF

netoutFile - Export - Netlist w/Properties

feedbackFile - Export - Logic

pin_delay inFile - Import - Pin Delay

annotation inFile - Import - Annotations

plctxt inFile - Import - Placement

signal atimesFile - Import - Active Times

techfile inFile - Import - Techfile

clppasteFile - Import - Sub-Drawing

pcad inFile - Import - PCAD

pads inFile - Import - PADS

specctra inFile - Import - Router

File

콘솔창 명령메뉴 항목
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pin_delay outFile - Export - Pin Delay

downrev2File - Export - Save Design to 15.2

downrevFile - Export - Save Design to 15.0

odb_outFile - Export - ODB ++ inside

ipc356 outFile - Export - IPC 356

icm_outFile - Export - InterComm

annotation outFile - Export - Annotations

plctxt outFile - Export - Placement

techfile outFile - Export - Techfile

dlibFile - Export - Libraries

clpcopyFile - Export - Sub-Drawing

specctra_outFile - Export - Router

idf outFile - Export - IDF

File

콘솔창 명령메뉴 항목

exitFile - Exit

scriptFile - Script

toolswapFile - Change Editor

file_propertyFile - Properties

plotFile - Plot

plot preview
File - Plot Preview 
(Windows only)

plot setupFile - Plot Setup

명령어 없음.File - File Viewer

viewlogFile - Viewlog

File

콘솔창 명령메뉴 항목

Appendix

- PCB Editor Command Index - / File
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delete vertexEdit - Delete Vertex

vertexEdit - Vertex

split plane createEdit - Split Plane - Create

split plane paramEdit - Split Plane - Parameters

zcopy shapeEdit - Z-Copy

deleteEdit - Delete

changeEdit - Change

spinEdit - Spin

mirrorEdit - Mirror

copyEdit - Copy

moveEdit - Move

redoEdit - Redo

undoEdit - Undo

Edit

콘솔창 명령메뉴 항목

net_propertiesEdit - Net Properties

property editEdit - Properties

groupeditEdit - Groups

text editEdit - Text

Edit

콘솔창 명령메뉴 항목

Appendix

- PCB Editor Command Index - / Edit
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- PCB Editor Command Index - / View, Add

명령어 없음.View - Customization - Toolbar

display paramView - Customization - Display

redisplayView - Refresh

colorview restoreView - Color View Restore Last

colorview createView - Color View Save

zoom previousView - Zoom Previous

zoom centerView - Zoom Center

zoom worldView - Zoom World

zoom outView - Zoom Out

zoom inView - Zoom In

zoom fitView - Zoom Fit

zoom pointsView - Zoom By Points

View

콘솔창 명령메뉴 항목

add textAdd - Text

add frectAdd - Frectangle

add rectAdd - Rectangle

add circleAdd - Circle

add arcAdd - 3pt Arc

add rarcAdd - Arc w/Radius

add lineAdd - Line

Add

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Display

restore_waived drcs
Display - Waive DRCs - Restore 
All

restore_waived drcDisplay - Waive DRCs - Restore

blank waived drcsDisplay - Waive DRCs - Blank

show waived drcsDisplay - Waive DRCs - Show

waive drcDisplay - Waive DRCs - Waive

dehilightDisplay - Dehighlight

hilightDisplay - Highlight

show propertyDisplay - Property

show parasiticDisplay - Parasitic

show measureDisplay - Measure

show elementDisplay - Element

color priorityDisplay - Color Priority

color192 또는 colorDisplay - Color/Visibility

Display

콘솔창 명령메뉴 항목

unrats netDisplay - Blank Rats - Nets

unrats componentDisplay - Blank Rats - Components

unrats allDisplay - Blank Rats - All

rats netDisplay - Show Rats - Net

rats componentDisplay - Show Rats - Components

rats allDisplay - Show Rats - All

Display

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Setup

define listSetup - Define Lists

define propertySetup - Property Definitions

dfa_spreadsheetSetup - DFA Constraint Spreadsheet

cmgrSetup - Electrical Constraint Spreadsheet

cnsSetup - Constraints

auto define bbviaSetup - Vias - Auto Define B/B Via

define bbviaSetup - Vias - Define B/B Via

define xsectionSetup - Cross-section

define subclassSetup - Subclasses

define gridSetup - Grids

define textSetup - Text Sizes

statusSetup - Drawing Options

drawing paramSetup - Drawing Size

Setup

콘솔창 명령메뉴 항목

envedSetup - User Preferences

keepin photoSetup - Areas - Photoplot Outline

keepout glossSetup - Areas - Gloss Keepout

keepout probeSetup - Areas - Probe Keepout

keepout viaSetup - Areas - Via Keepout

keepout routerSetup - Areas - Route Keepout

keepin routerSetup - Areas - Route Keepin

package_heightSetup - Areas - Package Height

keepout package
Setup - Areas - Package 
Keepout

keepin packageSetup - Areas - Package Keepin

Setup

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Layout

label partLayout - Labels - Part Number

label toleranceLayout - Labels - Tolerance

label valueLayout - Labels - Value

label deviceLayout - Labels - Device

label refdesLayout - Labels - RefDes

slideLayout - Slide

add connectLayout - Connections

add pinLayout - Pins

Layout 메뉴는 Symbol Editor 창에서만 나타납니다.

Layout

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Shape

island_deleteShape - Delete Islands

shape edit boundaryShape - Edit Boundary

shape void copyShape - Manual Void - Copy

shape void moveShape - Manual Void - Move

shape void elementShape - Manual Void - Element

shape void deleteShape - Manual Void - Delete

shape void circleShape - Manual Void - Circular

shape void rectangleShape - Manual Void - Rectangular

shape selectShape - Select Shape or Void

shape void polygonShape - Manual Void - Polygon

shape add circleShape - Circular

shape add rectShape - Rectangular

shape addShape - Polygon

Shape

콘솔창 명령메뉴 항목

shape global param
Shape - Global Dynamic 
Params

decompose shapeShape - Decompose Shape 

compose shapeShape - Compose Shape 

shape checkShape - Check

shape merge 
shapes

Shape - Merge Shapes

shape change typeShape - Change Shape Type

Shape

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Logic

ecl paramLogic - Terminator Assignment

partlogicLogic - Part Logic...

parteditLogic - Change Parts

rename area listLogic - Auto Rename RefDes - List

rename area windowLogic - Auto Rename RefDes - Window

rename area roomLogic - Auto Rename RefDes - Room

rename area designLogic - Auto Rename RefDes - Design

rename param
Logic - Auto Rename RefDes -
Rename

assign refdesLogic - Assign RefDes

identify netsLogic - Identify DC Nets

diff pairsLogic - Assign Differential Pair

net scheduleLogic - Net Schedule

net logicLogic - Net Logic

Logic

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Place

swap pinsPlace - Swap - Pins

place interactivePlace - Interactive

place area listPlace - Autoplace - List

place area windowPlace - Autoplace - Window

place area roomPlace - Autoplace - Room

place area designPlace - Autoplace - Design

place set bottomgridPlace - Autoplace - Bottom Grids

place set topgridPlace - Autoplace - Top Grids

place paramPlace - Autoplace - Parameters

place insightPlace - Autoplace - Insight

specctraPlace - Router

quickplacePlace - Quickplace

place manualPlace - Manually

Place

콘솔창 명령메뉴 항목

refresh symbolPlace - Update Symbols

eval area listPlace - Evaluate - List

eval area windowPlace - Evaluate - Window

eval area roomPlace - Evaluate - Room

eval area designPlace - Evaluate - Design

eval paramPlace - Evaluate - Parameters

swap area listPlace - Autoswap - List

swap area windowPlace - Autoswap - Window

swap area roomPlace - Autoswap - Room

swap area designPlace - Autoswap - Design

swap paramPlace - Autoswap - Parameters

swap componentsPlace - Swap - Components

swap functionsPlace - Swap - Functions

Place

콘솔창 명령메뉴 항목

Appendix
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guideportPlace - Design Partition - Guideports

workflowPlace - Design Partition - Workflow Manager

partitionPlace - Design Partition - Create Partitions

replace temp_symbolsPlace - Replace SQ Temporary - Symbols

replace temp_devicePlace - Replace SQ Temporary - Devices

Place

콘솔창 명령메뉴 항목

- PCB Editor Command Index - / Place

Appendix
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- PCB Editor Command Index - / Route

spread_between_voidsRoute - Spread Between Voids

unmiter_by_pickRoute - Unmiter by Pick

miter_by_pickRoute - Miter by Pick

specctraRoute - Router Editor

auto_routeRoute - Route Automatic

elong_by_pickRoute - Elongation by Pick

route_by_pickRoute - Route Net(s) by Pick

fanout_by_pickRoute - Fanout by Pick

specctra checksRoute - Router Checks

custom smoothRoute - Custom Smooth

delay tuneRoute - Delay Tune

slideRoute - Slide

add connectRoute - Connect

Route

콘솔창 명령메뉴 항목

gloss area listRoute - Gloss - List

gloss area highlightRoute - Gloss - Highlight

gloss area windowRoute - Gloss - Window

gloss area roomRoute - Gloss - Room

gloss area designRoute - Gloss - Design

gloss paramRoute - Gloss - Excute

Route

콘솔창 명령메뉴 항목

Appendix
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- PCB Editor Command Index - / Analyze

tline calculatorAnalyze - Transmission Line Calculator

emcontrolAnalyze - EMI Rule Checker

signal xtalktableAnalyze - SI/EMI Sim - Xtalk Table

signal probeAnalyze - SI/EMI Sim - Probe

signal libs audit Analyze - SI/EMI Sim - Audit - Audit List of Libraries

signal lib audit Analyze - SI/EMI Sim - Audit - Audit One Library

signal audit netAnalyze - SI/EMI Sim - Audit - Net Audit

signal auditAnalyze - SI/EMI Sim - Audit - Design Audit

signal prefsAnalyze - SI/EMI Sim - Preferences

signal model refreshAnalyze - SI/EMI Sim - Model Dump/Refresh

signal modelAnalyze - SI/EMI Sim - Model

signal libraryAnalyze - SI/EMI Sim - Library

signal initAnalyze - SI/EMI Sim - Initialize

Analyze

콘솔창 명령메뉴 항목
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- PCB Editor Command Index - / Manufacture

create detailManufacture - Dimension/Draft - Create Detail

draft filletManufacture - Dimension/Draft - Fillet

draft chamferManufacture - Dimension/Draft - Chamfer

leader chamferManufacture - Dimension/Draft - Chamfer Leader

leader balloonManufacture - Dimension/Draft - Balloon Leader

leader radialManufacture - Dimension/Draft - Radial Leader

leader diametralManufacture - Dimension/Draft - Diametral Leader

leader onlyManufacture - Dimension/Draft - Leader Lines

dimension angularManufacture - Dimension/Draft - Angular Dim

dimension datumManufacture - Dimension/Draft - Datum Dim

dimension linearManufacture - Dimension/Draft - Linear Dim

linefontManufacture - Dimension/Draft - LineFont

draft paramManufacture - Dimension/Draft - Parameters

Manufacture - Dimension/Draft

콘솔창 명령메뉴 항목 PCB 편집창의
Manufacture - Dimension Draft 메뉴는
Symbol 편집창의 Dimension 메뉴와
동일
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silkscreen paramManufacture - Silkscreen

create couponsManufacture - Create Coupons

dfaManufacture - DFx Check (legacy)

cut marksManufacture - Cut Marks

ncrouteManufacture - NC - NC Route

nctape_fullManufacture - NC - NC Drill

ncdrill paramManufacture - NC - NC Parameters

backdrill setupManufacture - NC - Backdrill Setup and Analysis

ncdrill legendManufacture - NC - Drill Legend

ncdrill customizationManufacture - NC - Drill Customization

stream outManufacture - Stream Out

film paramManufacture - Artwork

Manufacture

콘솔창 명령메뉴 항목

- PCB Editor Command Index - / Manufacture
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variant bomManufacture - Variants - Create Bill of Materials

variant assemblyManufacture - Variants - Create Assembly Drawing

thievingManufacture - Thieving

testprep resequenceManufacture - Testprep - Resequence

testprep densityManufacture - Testprep - Density Check

testprep ncdrillManufacture - Testprep - Create NC drill data

testprep createfixtureManufacture - Testprep - Create FIXTURE

testprep fixManufacture - Testprep - Fix/unfix testpoints

testprep propertiesManufacture - Testprep - Properties

testprep manualManufacture - Testprep - Manual

testprep automaticManufacture - Testprep - Automatic

Manufacture

콘솔창 명령메뉴 항목

- PCB Editor Command Index - / Manufacture
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- PCB Editor Command Index - / Tools, Help

techfile compareTools - Technology File Compare

reportsTools - Reports

derive connectivityTools - Derive Connectivity

silkscreen paramTools - Silkscreen

editpad restore allTools - Pad - Restore ALL

editpad restoreTools - Pad - Restore

editpad boundaryTools - Pad - Boundary

refresh padstackTools - Padstack - Refresh

multpadeditTools - Padstack - Group Edit

replace padstackTools - Padstack - Replace

padeditlib
Tools - Padstack - Modify Library 
Padstack

padeditdb
Tools - Padstack - Modify Design 
Padstack

create moduleTools - Create Module

Tools

콘솔창 명령메뉴 항목

drc updateTools - Update DRC

dbdoctorTools - Database Check

setup advisorTools - Setup Advisor

Tools

콘솔창 명령메뉴 항목

aboutHelp - About 

cdsdocHelp - Manuals

cdsdocHelp - Help

Help

콘솔창 명령메뉴 항목
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- PCB Editor Preference Index / Categories Description

Gerber 4x/6x 형식의 Film을선택하거나읽을경우, Flash Symbol(Triangle)의크기를지정한다. 기본값은 C-Point 
size(80mil)이고, 치수단위는도면서식의설정을따른다. 크기값은숫자와단위(mil, micron)로구성된다.loadgerber_flash_size

Artwork 인터페이스의 Film 목록을 14.2 이전방식의정리되지않은순서로표시한다. Film 설정전에 Stackup 설정이먼저
되어있다면, Film 목록은 Stackup된순서로표시될것이다.film_nosort

Manufacture -> Artwork 창을열면표시되는경고대화상자를띄우지않는다. 단, photoplot.log에는경고가기록으로남는다.artwork_no_unit_warn

Artwork Film의 Comment 항목에포함되는파일경로정보에서디렉터리정보를제거하고, 파일명만
기록한다.art_stripdirectoryname

벡터화된 Arc, Circle을구성하는 Line Segment 개수를지정한다. 15.7부터는새로운벡터화알고리즘이적용되고있으며, 이
옵션을사용하려면 arc_oldvectorize 옵션도같이활성화해야한다.art_circvects

15.5 이전방식의 Arc 벡터화알고리즘을사용, art_circvects 기능을켜려면이옵션도같이활성화해야한다.arc_oldvectorize

Allegro Artwork 및 Artwork 사용자인터페이스옵션

CATEGORY:  artwork
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자동저장주기를분단위(10분 ~ 300분)로지정한다. 기본값은 30분이다.autosave_time

자동저장에사용할파일명(확장자는넣지말것!!)을지정한다. 기본값은 AUTOSAVE.brd(또는 dra)autosave_name

자동저장전에 DB 내용을점검한다.autosave_dbcheck

autosave를활성화한다.autosave

자동저장설정

CATEGORY:  autosave

- PCB Editor Preference Index / Categories Description
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padeditlib(Tools->Padstack->Modify Library Padstack)명령에서 library path browser 대신, file browser를사용한다.padlib_filebrowser

SCRIPTPATH를지원하는 Allegro data browser 대신, 13.6 이전버전에서사용되었던 File Browser를사용.old_scriptbrowser

이전작업파일대신, unnamed.brd를연다. 12.0 이전버전의기능nolast_file

%알레그로설치경로%/pcbenv/allegro.ini 에이전작업디렉터리대신, 기본설정된작업디렉터리를사용한다. 12.0 이전
버전의기능

nolast_directory

MS-Windows OS에서파일관리자를변경한다. 기본값은 explorer.exefilemgr_windows

Unix OS에서파일관리자를변경한다. 기본값은그놈노틸러스filemgr_unix

Sub_Drawing의 clpcopy command에대해서 Windows 3.1 형식의파일브라우저를사용한다.
(13.6 이전버전의기능)clip_filebrowser

Windows 3.1 형식의파일브라우저를사용한다.browser_win31

Browse 창이열릴때의디렉터리위치를현재작업중인디렉터리로지정한다. 이옵션을설정하지않을경우 Browse 창이
열릴때의디렉터리위치는마지막으로이동했거나, 파일을읽어들인디렉터리로이동하게된다.browser_nosticky

브라우저창의 change directory 체크박스의기본값을일괄적으로체크안함으로설정한다. 한예로, File->Open의 Browse 
창은항목에기본적으로체크가되어있으나, File->scripts의 Browse 창은체크가해제
되어있다.

browser_nodircheck

브라우저설정

CATEGORY:  browser

- PCB Editor Preference Index / Categories Description
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크로스토크테이블파일경로지정(*.xtb)xtalk_table_path

Allegro 템플릿(*.brd,*.dra 생성용 Wizard) 파일경로지정wizard_template_path

색상파일경로지정(*.color)viewpath

extracta 명령파일경로지정(*.txt)textpath

스크립트파일경로지정(*.scr)scriptpath

NC Drill 파일경로지정(*.txt)ncdpath

materials.dat(Allegro) 또는 mcmmat.dat(Allegro Package Designer) 파일경로지정materialpath

DFA 보고서(Audit) 파일경로지정(*.arl, *.rle)dfaauditpath

라이브러리디바이스파일경로지정(*.txt)devpath

SubDrawing(*.clp) 경로지정clippath

Artwork aperture/param 파일경로지정 (art_aper.txt, art_param.txt)artpath

Aperture flash 파일경로지정.(*.fsm, *.bsm)aptpath

환경설정검색경로설정

CATEGORY:  config_paths

- PCB Editor Preference Index / Categories Description
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제어판의 World View에서 VOLTAGE 속성의 net을강조표시한다.(14.0 이전형식) 기본적으로 net이아닌, pin만표시한다.wv_voltage_nets

reject list에포함된객체의표시방법지정(none, blink, highlight, 기본값 : blink)find_reject_graphics

두개이상의객체를선택한상태에서 Reject 명령사용중, Reject 할객체의 List를보이지않게하거나(Always), 특정개수
이상일때만보이도록설정(1~5)find_nongui_reject

명령선택후, 사용자가설정한제어판의탭(Option, Find, Visibility)으로자동이동, 기본값은탭이동을
하지않음

control_auto_raise

제어판 Visibility 탭의 Views 목록에서 Artwork Film들을감춤color_nofilmrecord

Color and Visibility 설정에서보여주는 Group의위치를제어판에서 Option 탭에표시된 Group의위치가
아닌이전실행에서가리켰던 Group으로선택

color_lastgroup

제어판 Option 탭에표시되는 add pin 명령옵션에서사용할기본간격값을지정, 치수단위는사용자가
원하는형태로입력하고, 입력된값은 Symbol unit의설정에맞추어변환된다.addpin_default_space

제어판의탭(Option, Find Filter, Visibility), WorldView 및그외사용설정

CATEGORY:  control_panel

- PCB Editor Preference Index / Categories Description
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토폴로지템플릿경로지정(*.top)topology_template_path

Reusable die pin tile 파일경로지정(*.til)tilepath

기술파일경로지정(*.tech)techpath

부품 Symbol 파일경로지정(*.psm, *.osm, *.bsm, *.ssm, *.fsm)psmpath

pcell 컴포넌트파일경로지정(*.il *.ile)pcell_lib_path

Padstack 파일경로지정(*.pad)padpath

Design Reuse 모듈파일경로지정(*.mdd)modulepath

라이브러리정의파일경로지정(*.ldf)ldfpath

DFA constraints spreadsheet 파일경로지정(*.dfa)dfacnspath

디커플링콘덴서목록파일의경로지정(*.dcf)dclpath

Design Search Path Settings

CATEGORY:  design_paths

- PCB Editor Preference Index / Categories Description
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Skeleton Display 금지설정(설정할경우화면표시속도감소)display_noskeletal_draw

Allegro 윈도창의위치및크기기억금지설정display_nosaved_geometry

객체(배선, Rats..)에대한재표시(Repaint) 금지설정display_norepair

부품이동중, RefDes를표시하지않게설정display_norefdes

디자인창에서배선폭을무조건 1mm로표현(속도개선효과)display_nolinewidth

강조된색상을 Solid형태로표현, 기본값은기본색상과강조색상(흰색)을섞어서표현display_nohilitefont

이동, 복사같은명령을사용시, arc를 1픽셀로표현display_nodynamicarcwidth

작업중인객체의색상을흰색으로강조하여표시display_nocolor_dynamics

작업중, dynamic shape boundary layer가보이게끔설정. 기본값은보이지않게함.display_no_auto_hide_boundary

배선중, Active Layer 전환에의해 Color priority가변경되지않도록설정, 기본값은 autopriority(Layer 변경에따라 Color 
priority도같이변경)display_manual_colorpriority

Solid type의 DRC marker 표시display_drcfill

창을이동하거나, 폼에의해가려진부분을 repainting 하기위한스크린캐시를설정한다.
(UNIX기반 X윈도전용)display_backingstore

솔라리스7의버그로인해표시되지않는일부라인을강제로보이게한다.bug_solaris_hlt_lines

디스플레이설정

CATEGORY:  display

- PCB Editor Preference Index / Categories Description
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Text를무조건 1픽셀로표시display_thintext

Analysis 클래스의 Shape Fill 형태를픽셀간격의선을긋는형태로표현display_shapefill_analysis

Solid type의 Shape Fill 형태를픽셀간격의선을긋는형태로표현, 기본값 5픽셀 (기존 4픽셀)display_shapefill

Shadow mode가적용되지않는비활성객체에대한색상명암비조정설정, 기본값 40%display_readonly_intensity

화면이동중, 그래픽카드의존에의한성능저하개선을위한설정(기본값은 on)display_raster_ops

디스플레이설정

CATEGORY:  display

Highlight SOV application의간격파라미터설정sov_spacing

Highlight SOV application active layer만표시되게설정sov_active_only

Highlight SOV application 설정

* SOV : Segment Over VoidCATEGORY:  display_SOV

- PCB Editor Preference Index / Categories Description
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uprev 관련경고대화상자를보이지않게설정noconfirm_uprev

*.dra 파일편집후저장할때 *.dra 소스파일만저장하고, *.bsm,psm 등의파일은컴파일하지않도록설정no_symbol_onsave

읽어들이는파일이협업으로작업한 System design일경우, 자동적으로관련링크를열게끔설정multiboard_always

mil 단위작업파일에서수소점자리수를 2보다큰값으로설정할때나타나는경고대화상자를보이지않게설정drawing_no_4mils_msg

mil 단위작업파일에서수소점자리수를 3~4자리로설정, 기본값은 2자리drawing_4mils

Product 간속성호환문제로표시되는대화상자를보이지않게설정(Command창에출력된다.)db_tier_nomsg

DB 접근작업설정

CATEGORY:  drawing

- PCB Editor Preference Index / Categories Description
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정확한 impedence / delay 계산을위하여, Shape / Plane의 Hole과 Cut-out을모두포함한동박의실제외형을구현(계산속도
느려짐, Plane layer의 Shield 플래그꺼짐)use_accurate_delay_calculation

45도각도배선에한해, 너무작은크기로생성된 segment jog를 DRC 체크를통해확인(45도이외의각도는사용불가)same_net_traps

12.0 이전의방식으로배선최대/최소 Delay Rule 점검pre_12.0_delay_rule

Multi-drill padstack에서 drill 배열이패드외곽을벗어날경우 Error 표시, 이경우해당 padstack은저장되지않음(기본값은
Warning 표시)padstack_hole_outside

배선의 Delay Rule Check에 Terminator length를포함(기본설정 : Terminator length 포함되지않음)include_terminators

DRC Check에서 Shape, Copper내부의 패드,Via 간이격 Rule을 Antipad 간의간격으로설정(Shape 바깥의패드,Via는
Regular Pad를적용)drc_old_pad_pad

동일명칭의 Net 배선에도 Fillet을고려한 DRC Check 수행drc_fillet_samenet

둔각배선의 Primary separation 오차허용치설정(예 : "10MIL:20MIL", 15.0 이전형식)drc_diff_pair_primary_separation_tole
rance

Diff pair net 간격이 primary spacing의값을초과할경우, DRC를무시하게끔설정 (오차허용치 - 0(DRC무시), 100(accuracy 
1단위),200, 15.0 이전형식)drc_diff_pair_overide

Constraints / Physical Rule Set 의 Current via list 목록을 Sort하지않도록설정(13.6 이전형식)cns_noviasort

DRC 설정

CATEGORY:  drc

- PCB Editor Preference Index / Categories Description
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배선중, 배선길이와같은배선정보표시allegro_etch_length_on

배선중나타나는 Dynamic timing feedback 표시창의위치를제어판에고정하거나커서주변에표시allegro_dynam_timing_fixedpos

배선중, Constraint Manager와연동하는 Dynamic timing feedback 기능을켜거나끔allegro_dynam_timing

배선 Layer를항상, 제어판 Option 탭의 Active Subclass에서부터시작하게끔설정acon_route_on_active_subclass

Group Route mode에서배선간격을 Current Space로설정하지않고, 앞에작업한 Space 값을적용acon_restore_space_mode

Add connect 명령에서강조표시할부분을결정(From to - 작업중인패턴부, All - 해당 Net 전체, Off, 기본값 : 속성에서
NO_RAT 또는 POWER_AND_GROUND가설정되지않은모든 Net 전체강조)acon_oldhlt

Add connect 명령에서 Bubble 처리방법결정(Hug, End point 지정, 무시)acon_offnet_snap

Add connect 명령에서배선폭에대한 impedence rule을적용하지않음(기본값은 impedence rule에맞는배선폭의최소값
적용)acon_no_impedance_width

45도배선에서사선(45도) 배선도중잠시작업을종료했다가다시재작업할경우, 배선방향을그대로유지(기본값수직방향)acon_diag

동박(Etch) 설정

CATEGORY:  etch

- PCB Editor Preference Index / Categories Description
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기본적으로 Slide mode에서수정중인 Cline Segment를인접한배선의 Cline에 Snap(배선간정렬) 하게끔되어있으며, 
체크할경우 Snap 하지않음

slide_no_snap

배선완료된 Rat Ts의표시방법결정(on : 배선완료와동시에바로숨김, Unhighlight : 강조시에만표시)ratt_off_if_connected

Rats Nest의표현형태를 0.0 ~ 1.0 사이의값으로지정(0.0 - Manhattan Length(최단거리), 1.0 - 수직/수평표시)rats_factor

두개이상의 Net 배선에서 Pin/Via Spacing Rule의값을 %단위로작게설정(Pin/Via Space = 100%)padentry_factor

오류발생시배선의 Center line 표시로 DRC를표시하지않음no_show_dynam_elec_errors

(Via Shove가허용된상태에서)Bond Pad의 Shove 허용(기본값 : Bond Pad Shove 금지)bubble_shove_bondpads

배선중, 화면에표시되지않는객체가배선의영향을받아, Bubble 될경우이를표시하지않음(기본값 :  Bubble 내역표시)bubble_no_display_invisible

동박(Etch) 설정

CATEGORY:  etch
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작업물의임시저장경로설정 - pcbenv 디렉터리(일반적으로사용자계정의 Home 디렉터리로지정되며, env파일(환경변수
저장파일)은알레그로설치경로에존대하는 global 파일보다 Home 디렉터리의 local 사용자파일이우선권을가집니다. 
윈도의경우 x:\document and settings\사용자폴더로지정되므로, 가급적최초실행후, 찾기쉬운경로로변경하는것이차후
환경변수설정을위해좋습니다.)

temp

저널파일에삽입할접두사의내용(ex : 접두사_allegro.jrl)journal_prefix

저널파일을이용한파일출력의버퍼링금지(기본값 : 버퍼링허용)journal_nobuffer

작업물(*.brd, *.심볼, *.log) 외파일들의백업저장수(기본값 : 2)ads_textrevs

리포트파일이저장될하부폴더경로ads_sdreport

Plot(파일로저장된인쇄물)파일이저장될하부폴더경로ads_sdplot

로그파일이저장될하부폴더경로ads_sdlog

artwork film 파일이저장될하부폴더경로ads_sdart

저장되는로그파일의수ads_logrevs

작업결과물(*.brd, *.심볼)의백업저장수(이전버전은확장자뒤에숫자가추가되며, 기본값 : 1)ads_boardrevs

자동저장되는파일의수(기본값 : 0)ads_autosaverevs

파일버전, 리비전조정관련설정

CATEGORY:  file_management
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패드형상을사각형으로간주하여패드로의배선접속을개선할것인지의여부gloss_pad_shape

Gloss 실행중 DRC 동시실행여부cbd_check

Gloss 설정

CATEGORY:  gloss

(Package Geometry에속한부품외형클래스)해당클래스를활성화(IDF_PLACE_BOUNDS_BOTTOM도활성화되어야
한다.)idf_place_bounds_top

(Package Geometry에속한부품외형클래스)해당클래스를활성화(IDF_PLACE_BOUNDS_TOP도활성화되어야한다.)idf_place_bounds_bottom

IDF파일의 .PLACEMENT와 .NOTES 항목을제외한나머지부분을 import하지않음(=기존 Data 내용을유지)idf_nodelete

ifd_out의 PART_NUMBER 속성무시(심볼에정의된 device type으로대체)idf_ignore_part_number

idf_out의 comp_height설정무시(심볼에정의된 height value로대체)idf_ignore_comp_height

IDF (Mechanical Interface) 관련설정

CATEGORY:  idf
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Find 등으로객체를찾을때, 찾은객체를화면에꽉차게확대하는기능을비활성화no_zoom_to_object

마우스가운데버튼(또는휠)을이용한 dynamic zoom 기능비활성화(도면이동및, memorized zoom in, zoom out 기능으로
변경됨)no_dynamic_zoom

마우스제스처의입력방식변경(CTRL+마우스오른쪽버튼 -> 마우스오른쪽버튼), 설정여부에관계없이마우스오른쪽
팝업메뉴사용가능

no_dragpopup

Enter키를 Tab키의역할(OK버튼입력이아닌, 다음항목이동)로설정form_oldreturn

funckey등의예약명령어가입력될때, 자동으로 Enter 키가입력되는것을방지(15.0이전의방식으로변경하는것을
의미하며, 마우스포인터가콘솔창에위치할때는이항목의설정에상관없이 Enter키는입력되지않는다. 기본값 : Enter 
키자동입력허용)

canvascommandmode

취소키지정(기본값 : CTRL+C, 사용가능한키 : 알파벳/숫자, CTRL+알파벳,<ESC>)cancel_key

키보드, 마우스입력설정

CATEGORY:  input
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net logic 명령(배선연결변경등) 활성화logic_edit_enabled

Cross-Probe를이용하여들어오는외부프로그램의선택강조표시를사용하지않음ignore_external_highlight

die 나 package에서삭제된 symbol 부품의배치되지않은일부로남기도록설정.(15.5 이전의방식, 기본값 : 독립적인
symbol로인정하여제거시해당 symbol을삭제)icpkg_unplace_comps_on_delete

Auto rename 작업에서 Refdes의시작순번을특정숫자로지정fst_ref_des

Dimension/Draft 명령실행시, 활성 Layer를현재의 Layer로유지(기본값 : Board Geometry / Dimension layer로전환)draft_retain_class_subclass

DC net 설정에서 Power and Ground 속성이할당된 Net들의 NO_RAT 설정을제거dcnets_delete_norat

AutoSilk 실행중, Solder_mask 영역이지정되지않은 via에대해서도 clear 작업실행autosilk_disregard_solder_mask

15.2 이전에사용된 text 기반 report를사용(기본값 : HTML 기반 report, 이항목을사용하지않더라도, consol창에서
old_reports 명령으로 text 기반 report를출력할수있다. old_reports 명령은이후버전에서삭제예정)allegro_old_report

라이센스보유여부에관계없이모든라이센스항목을표시all_license_choices

기타설정

CATEGORY:  misc
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PCB SI의 cross-section 메뉴를사용(주의 : Layer수가많아지면느려질수있고, 기존 Xsection 아이콘은제거됨, 퍼포먼스
옵션이탑재되거나 6xx 이상에서만설정및사용가능)xsection_modern

모듈간 Swap에나타나는확인창을제거(15.0 이전방법)swapcomp_acrossmodules

회로도면편집프로그램지정schematic_editor

부품에속한 Text Block Size가 Board의 Text Block Size 설정과일치하는것을허용하지않음(12.0 이후버전에서는부품을
배치할때, 부품의 Text를 Board의 Text설정에맞추려한다, 기본값 : Text 설정일치허용))preserve_symbol_textblocks

Backannotation 작업중, function을정의해야하는핀의변경기준을핀이름이아닌핀번호로설정pcb_baf_pin_number

14.0 이전방식의 Thermal Flash Symbol 사용old_style_flash_symbols

핀스왑또는게이트스왑중패턴해제를하지않도록설정(Component Swap에서는해당되지않음, 기본값 : 패턴해제허용)noswapripup

NC Drill Legend(드릴차트)의템플릿을위한별도의파일경로지정(파일명외의경로등의내용이들어가서는안되며, 템플릿
검색경로는환경설정 config path 카테고리의 ncdpath에지정된경로를참고)nclegend_file

기타설정

CATEGORY:  misc
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UNIX 전용 : 인쇄시사용할 Print Device를 lp 대신다른것으로사용하고자할경우지정print_unix_command

MS-Windows 전용 : 인쇄에사용할외부프로그램을해당프로그램에서사용하는확장자이름으로지정(주의 : txt파일이
메모장이아닌그림판에할당되어있으면, 인쇄작업을진행하는주체는메모장이아니라그림판이된다.)print_nt_extension

Text를벡터화하여인쇄(plot setup의 IPF setup 또는위의 plot_vectext_width 설정을따르며, *.ini 파일에의해설정이변경될
수있다.)plot_vectorize_text

Vectorized text Line의 width 값(주의 : plot_vectorize_text가활성화되어야한다. *.ini 파일에저장된 plot_setup 설정이
우선시한다.)plot_vectext_width

Shape를구성하는선간격설정(인쇄속도향상을목적)plot_shape_spacing

여백없이인쇄(기본값 : 1인치가량의여백할당, MS-Windows 전용설정)noplotmargins

인쇄설정

CATEGORY:  plot

키보드화살표키를이용한화면이동간격거리를픽셀단위로설정(16px 단위로설정을권장, 설정가능한픽셀범위 : 16 ~ 
256px, 기본값 : 96px)roaminc

화면이동거리를밀리초단위시간간격의형식으로설정(ex : 1000(ms)은초당 1씩이동, 기본값 : 250(ms))pcb_autoroam

Roam - 화면이동설정

CATEGORY:  roam

- PCB Editor Preference Index / Categories Description

Appendix



210

Allegro PCB Editor

Route keepin 바깥에배치된 Shape를자동으로자르지않고 DRC 오류만생성(기본값 : Route keepin 바깥의 Shape를
자동으로제거, 15.5 이전의기능을복원)shape_noclip_rki

마우스를이용한 Shape 전체이동허용shape_drag_move

Shape 명령을호출할때, 나타나는기본 Shape 유형을지정(이설정에관계없이 Shape 명령호출시, 제어판에는직전에
사용한 Shape 유형이선택되어져있다.)shape_add_filltype

패드주변이격값추가(지정된값은적용후, shape parameter의 DRC 이격설정에더해진다)pad_drcplus

Shape를 Line Hatch로채움old_shape_fill_style

Shape 채움사용하지않음(Shape의이격선을포함한외곽선만표현됨)no_shape_fill

MS-Windows 전용, stipple(점묘화) 패턴으로 shape를채움(기본값 : Line hatch, 화면이울렁거릴경우윈도의색상을 16Bit 
색상으로변경하면해결가능하다)new_shape_fill_nt

Shape를선택할때 Shape에할당된 Net도같이강조하여표시highlight_shape_net

Cline 종료점주변의 Void 유형을결정(Dynamic shape 전용, 기본값 : octagon)dv_endcapstyle

Thermal Relief 생성중, 핀으로부터추가이격거리또는 Shape 대 Pin 연결 Line의길이설정(Static shape 전용, 기본값 : 
5(mil))av_thermal_extend

(수직으로배열된동일한크기의 Pin에한해)Pin의그룹 Void 여부를핀간의거리로결정(Static shape 전용, 적용범위 : 0 ~ 
100(mil), 기본값 : 100(mil), 적용조건 : Static shape의 Parameter -> Void Control -> Create pin Voids를 In-Line으로설정)av_inline

Cline 종료점주변의 Void 유형을결정(Static shape 전용, 기본값 : octagon)av_endcapstyle

Shape 설정 - dynamic / static

CATEGORY:  shape
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배선정보를 PCB SI 형식으로표시(Allegro 또는 Allegro Package Designer 전용)showelement_highspeed

객체의세부항목정보를필터링showelement_brief

영역의크기를 Board Unit 대신 Inch^2 또는 Cm^2 의단위로표시showelement_basearea

주작업창을피하여 Element 창을표시(기본값 : 미리기억된이전위치에서 Element 창표시)showelement_autoavoid

하나의 net에대해서 Manhattan Length정보의표기를허용할최대 Pin 연결수(적용범위 : 0 이상의자연수, 기본값 : 50, 
하나의 net에 50개이상의핀이연결되어있으면, 퍼포먼스문제로인해 Show Element에서는 Manhattan Length 정보를
표기하지않는다. NO_RAT 속성을갖고있는 PIN은설정여부에관계없이 Manhattan Length를표기하지않는다)

show_max_manhattan_pins

미리선택된(한개또는그이상) 객체의정보를표시하지않으며, Show Element 명령은다른명령과같이수행가능한동시
실행이아닌단일실행명령으로변경된다

noshow_current_selections

Show Element 기능설정

CATEGORY:  show_element
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Signoise 모델관련파일경로(*.dat, *.wave, *.ibs, *.ctl)signoisepath

추가(optional) signoise 모델라이브러리를보유하고있는폴더경로를지정signal_optlib_dir

표준 signoise 모델라이브러리를보유하고있는폴더경로를지정signal_install_dir

component를 device model에할당할때, 각핀에대한 pin use code를덮어씌우는것을금지(기본값 : 허용)sig_pinuse_frozen

Signal Model Assignment 폼에서 "Include ORIGINAL Model Path in Map File" 옵션사용(선택 : 0 또는 1, 기본값 : 0(해당
옵션사용하지않음))sig_mapfile_orgpath

Loss Tangent 값이최대가되는주파수위치지정(기본값 : 1 Ghz, 신호주파수에대한유전손실탄젠트(Loss Tangent) 
비선형적의존성제어)

frequency_at_max_loss_tangent_in_g
hz

Timestep 단위이하의전송시간을가질정도로짧은 Cline Segment도모두시뮬레이션가능하게모델화하도록설정enforce_welement_simulation

S파라미터를포함하는시간영역해석의속도개선directconvolutionwithapproximation

기생성분계산(Display -> Parasitic) 명령은선택한동박의특성(임피던스, 딜레이등)을나타내며, 이속성을설정하면추가로
인접지역이 Cross-Talk 및 multi-trace 모델명을표시한다.anl_show_coupled_trace

해석에서적용할 Shape의최소 Void 영역을 mil 단위로지정(기본값 : 99(mil), 입력값이 99(mil) 일때 99x99 mils^2의크기를
최소 Shape Void 영역으로사용 )anl_min_void_area

신호해석설정

CATEGORY:  signal_analysis
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Shield Layer의 Hole을 delay 계산에포함use_accurate_delay_calculation

배선의단면을직사각형이아닌사다리꼴로적용할경우하단예각의각을입력(값의입력이없을경우 90도=직사각형)trapezoidal_angle_in_degree

Diff-pair 모델이없지만, 사용자가 Diff-pair로지정한 Net 들을쌍으로 Net topology 추출(기본값 : 사용자 Diff-pair 설정을
무시하고단일 Net topology 추출)sq_enable_udiff_extraction

Shape화하지않고 Trace로모델링하고자하는 Trace의최대선로폭(기본값 : 40(mil))sn_maxwidthlimit

시뮬레이션이후에도생성된 circuit file을보존(기본값 : 시뮬레이션완료후, circuit file 삭제)simsavefiles

SignalXP의라이센스강제지정sigxp_tier

T-line 지연을길이로표현(기본값 : 시간으로표현)sigxp_length_mode

SignalXP에서작성된토폴로지를이전버전 Constraint Manager로 import 허용(이전버전에사용되지않는구성요소는모두
무시됨)sigxp_allowoldrevs

신호해석설정

CATEGORY:  signal_analysis
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스크립트개발용 Skill 명령콘솔실행허용telskill

MS-Windows 전용, telskill 입력창의폭설정(입력범위 : 40 ~ 140, 기본값 : 80)skill_width

기존의 ilinit파일을 Load(기본값 : 기본폴더(%프로그램설치경로%/pcb/etc/skill 또는 $HOME/pcbenv 또는
$ALLEGRO_SITE/skill)에서 ilinit Load)skill_old_ilinit

MS-Windows 전용, telskill 입력창의줄기억설정(입력범위 : 40 ~ 2500, 기본값 : 24)skill_linebuffer

MS-Windows 전용, telskill 입력창의높이설정(입력범위 : 10 ~ 50, 기본값 : 24)skill_height

SKILL 설정

CATEGORY:  skill

알레그로 PCB SI 작업창의제목줄설정title_sigxp

알레그로패키지디자이너작업창의제목줄설정title_apd

알레그로 PCB Editor 작업창의제목줄설정title_allegro

작업창제목줄설정, 20자이하권장

CATEGORY:  title

- PCB Editor Preference Index / Categories Description
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(마우스포인터가무한십자일경우)마우스포인터의회전각설정(각범위 : 0 ~ 90)pcb_cursor_angle

마우스포인터의형태를작은십자또는무한십자의형태로표시pcb_cursor

스크립트파일등록/저장중, add/reset 버튼등의실행을스크립트내역에기록하지않음noformscriptbutton

동작확인을위한대화상자를띄우지않음noconfirm

프로그램을시작중, 프로그램정보창을보이지않음noabout

UNIX 전용, HTML 창을새창으로실행http_newwindow

UNIX 전용, 기본 HTML 뷰어를변경(기본값 : 넷스케이프)http_netscape

윈도폼에적용될글꼴굵기지정(기본값 : 400)fontweight

윈도폼에적용될글꼴크기지정(기본값 : 12)fontsize

윈도폼에사용되는고정폭글꼴지정(기본값 : Courier, 한글글꼴이름입력금지!!)fontfixedface

윈도폼에사용되는가변폭글꼴지정(기본값 : MS Sans Serif, 한글글꼴이름입력금지!!)fontface

내장브라우저의텍스트크기를설정(기본값 : medium)browser_text_size

모든메시지를 HTML 형식으로출력allegro_html

사용자입력환경설정

CATEGORY:  ui

- PCB Editor Preference Index / Categories Description

Appendix



216

Allegro PCB Editor

프로그램시작시, 실행할스크립트의위치지정(ex : 이름을 myscript 로지정하면, 프로그램시작시, 알레그로는
allegro_myscript.scr, 패드디자이너는 pad_designer_myscript.scr 을찾음)script_startup

스크립트재생중스크립트다이얼로그를열린상태로유지script_keepformopen

리포트메뉴창의높이(줄단위) 지정(입력범위 : 20 ~ 70)report_height

최근작업한파일(Recent Files)의개수지정(기본값 : 10)recentfilelist

프로그램시작중, README 파일보이지않음(15.0 이후로사용하지않음)readme_never

사용자입력환경설정

CATEGORY:  ui

- PCB Editor Preference Index / Categories Description
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사용자정의환경설정파일저장경로prfeditpath

메뉴폼파일저장경로menupath

UI 폼파일저장경로formpath

UI 구성파일저장경로설정(가급적손대지말것)

CATEGORY:  ui_paths

최대 Undo 명령기억수(범위 : 0 ~ 50, 기본값 10)undo_depth

최대 Undo/Redo 메모리사용량(범위 : 0 ~ 100MB, 기본값 : 4MB)max_undo_memory

Undo/Redo 설정

CATEGORY:  undo

풍선도움말의위치를제어판아래쪽에고정datatips_fixedpos

풍선도움말의출현지연시간datatips_delay

마우스오버된위치의객체에대한정보를풍선도움말로표시, 명령수행중해당명령에서선택가능한객체의정보만표시datatips

차기버전추가기능(기능은구현되었으나, 검증되지않음)

CATEGORY:  z_early_adopter

- PCB Editor Preference Index / Categories Description
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- DRC Error code description -

Max Final Settle Max, Min First Switch Min, Noise Margin Min, Overshoot Max, Propagation Delay Max,
Propagation Delay Min, Propagation Delay Path Type, Relative Propagation Delay Delta,
Relative Propagation Delay Path Type, Relative Propagation Delay Scope

E - D

MaxD - U

Line to Line SpacingD - S

Phase Tolerance - ToleranceD - P

Negative plane islandsD - I

DFA Package to packageD - C

Soldermask to soldermask

Package to package
C - C

Bond Pad to ShapeB - S

Bond Pad to LineB - L

Bond Pad to Bond PadB - B

Constraint ViolationCode
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- DRC Error code description -

Constraint ViolationCode

Bond Pad to Component Edge

Bond Pad to Bond Pad (same net)
F - F

Bond finger to component, Bond Pad to Component EdgeF - C

Active Window, Max Xtalk, Max Peak Xtalk, Sensitive Window, Maximum Inter Crosstalk,
Maximum Intra Crosstalk

E - X

Max Via CountE - V

Verify ScheduleE - T

Max Stub LengthE - S

ParallelismE - P

Layer Sets, Max Exposed Length, Total Etch Length Max, Total Etch Length MinE - L
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- DRC Error code description -

Constraint ViolationCode

Shape to Route Keepin, Shape to Route KeepoutK - S

Thru Pin to Route Keepin, Thru Pin to Route Keepout, SMD to Route Keepin, SMD to Route Keepout,
Test Pin to Route Keepin, Test Pin to Route Keepout, Test Pin to No ProbeK - P

Line to Route Keepin, Line to Route KeepoutK - L

Package to place keepin, Package to place keepoutK - C

Bond Pad to Route Keepin, Bond Pad to Route Keepout, Bond Pad to Via KeepoutK - B

Allow - TsJ - N

Single-line Impedance Target and ToleranceI - M
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- DRC Error code description -

Constraint ViolationCode

Line Width - Max, Line Width - Min, Neck - Max Length, Neck - Min WidthL - W

Shape to LineL - S

Line to LineL - L

Via to Route Keepin, Via to Route Keepout, Via to Via Keepout, BB Via to Route Keepin, BB Via to Route 
Keepout,
BB Via to Via Keepout, Test Via to Route Keepin, Test Via to Route Keepout, Test Via to Via Keepout,
Test Via to No Probe

K - V
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- DRC Error code description -

Constraint ViolationCode

Line to SMD Pin, Line to Test Pin, Line to Thru PinP - L

Bond Pad to SMD Pin, Bond Pad to Test Pin, Bond Pad to Thru PinP - B

Soldermask to ViaM - V

Soldermask to shapeM - S

Soldermask to PinM - P

Pad Soldermask to Pad SoldermaskM - M

Soldermask to pad and clineM - L

Symbol Soldermask to Pad SoldermaskM - C

Soldermask alignment, Pad Soldermask Alignment, Symbol Soldermask AlignmentM - A

Line Width - Max, Line Width - Min, Neck - Max Length, Neck - Min WidthL - W
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- DRC Error code description -

Constraint ViolationCode

Shape to ShapeS - S

Allow - EtchS - N

Package to roomR - C

SMD Pin to BB Via, SMD Pin to Test Via, SMD Pin to Thru Via, Test Pin to BB Via, Test Pin to Test Via,
Test Pin to Thru Via, Thru Pin to BB Via, Thru Pin to Test Via, Thru Pin to Thru Via

P - V

Shape to SMD Pin, Shape to Test Pin, Shape to Thru PinP - S

SMD Pin to SMD Pin, SMD Pin to Test Pin, Test Pin to Test Pin, Thru Pin to SMD Pin,
Thru Pin to Test Pin, Thru Pin to Thru PinP - P
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- DRC Error code description -

Constraint ViolationCode

BB Via to BB Via, BB Via to Test Via, Test Via to Test Via, Thru Via to BB Via, Thru Via to Test Via,
Thru Via to Thru ViaV - V

Shape to BB Via, Shape to Test Via, Shape to Thru ViaV - S

ViasV - N

Line to BB Via, Line to Test Via, Line to Thru ViaV - L

Allow - Pad-Pad Connect, BB Via Stagger - Max, BB Via Stagger - Min, Min BB Via GapV - G

Bond Pad to BB Via, Bond Pad to Test Via, Bond Pad to Thru ViaV - B

Testpoint loc. to component, Testpoint pad to component, Testpoint under componentT - C
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- DRC Error code description -

Constraint ViolationCode

Externally Determined ViolationX - D

Wire to wire (different profile)W - X

Wire to wire (same profile)W - W

Wire to pinW - P

Max. bonding wire lengthW - I

Wire to bond fingerW - F

Wire end to wire endW - E

Bonding wire diameterW - D

Min. bonding wire length, Wire to die edge angleW - A
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